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Copyright and Disclaimer
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The software described in this document is furnished under a license agreement. You can obtain a copy of 
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No part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, including photocopying and recording, for any purpose without the express written permission 
of Avid Technology, Inc.

Copyright © 2005 Avid Technology, Inc. and its licensors. All rights reserved.
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Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial 
computer software” or “commercial computer software documentation.” In the event that such Software or 
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iNEWS, iNEWS ControlAir, and Media Browse are trademarks of iNews, LLC.

Adobe, Acrobat, and Acrobat Reader are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries. Microsoft, Windows, and Windows XP are 
registered trademarks of Microsoft Corporation. All other trademarks contained herein are the property of 
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Footage
The Big Swell — Courtesy of Swell Pictures, Inc.

GOT FOOTAGE?

Editors — Filmmakers — Special Effects Artists — Game Developers — Animators — Educators — 
Broadcasters — Content creators of every genre — Just finished an incredible project and want to 
share it with the world?

Send us your reels and we may use your footage in our show reel or demo!*

For a copy of our release and Avid’s mailing address, go to www.avid.com/footage.

*Note: Avid cannot guarantee the use of materials submitted.

Avid DS Nitris Conform Guide • April 2005
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Using This Guide

Congratulations on your purchase of an Avid DS Nitris system. You can use 
your system to create broadcast-quality output incorporating every possible 
production element from full-speed, high-resolution footage, to multimedia 
artwork and animation, to computer-generated effects and titling.

This guide is intended for all Avid DS Nitris users, from beginning to 
advanced, who need to conform projects transferred from other systems 
through AFE, AAF, OMF®, EDL, and ALE files.

n The documentation describes the features and hardware of all models. 
Therefore, your system might not contain certain features and hardware that 
are covered in the documentation.
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, 
reminders, recommendations, and strong suggestions.

c A caution means that a specific action you take could 
cause harm to your computer or cause you to lose data.

w A warning describes an action that could cause you 
physical harm. Follow the guidelines in this document 
or on the unit itself when handling electrical 
equipment.

> This symbol indicates menu commands (and 
subcommands) in the order you select them. For 
example, File > Import means to open the File menu 
and then select the Import command.

t This symbol indicates a single-step procedure. 
Multiple arrows in a list indicate that you perform one 
of the actions listed.

Margin tips In the margin, you will find tips that help you perform 
tasks more easily and efficiently.

Italic font Italic font is used to emphasize certain words and to 
indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Bold font Bold indicates a user interaction.

Ctrl+key or mouse action Press and hold the first key while you press the last 
key or perform the mouse action. For example, 
Shift+Alt+C or Ctrl+drag.
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Mouse, Pen, and Keyboard

You can use a two-button mouse (with wheel) or a pen and tablet. The left and 
right mouse buttons perform different operations. Unless otherwise stated, use 
the left mouse button.

The mouse and pen operate slightly differently. All the procedures in this 
guide are documented for the mouse. You can, however, easily use a pen or 
the keyboard.

Customizing the Pen or Mouse

By customizing the pen, you can adjust the click pressure, switch functions, 
and other features. For information on customizing the pen, refer to the 
documentation provided with your Avid DS Nitris system.

You can also customize the mouse. For example, you can select left-handed 
configuration or change the double-click speed. For information on 
customizing the mouse, refer to the Windows online Help.

If You Need Help

If you are having trouble using Avid DS Nitris:

1. Retry the action, carefully following the instructions given for that task in 
this guide. It is especially important to check each step of your workflow.

2. Check for the latest information that might have become available after 
the documentation was published in one of two locations:

- If release notes are available, they ship with your application.

- If ReadMe files are available, they are supplied in your Avid 
application folder. ReadMe files are also available from Help.

3. Check the documentation that came with your Avid application or your 
hardware for maintenance or hardware-related issues.

4. See “Avid DS Customer Support” on page 14.

5. For Technical Support, please call 800-800-AVID (800-800-2843).
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Avid DS Customer Support

The following sections describe various Avid DS Customer Support options.

E-mail Support

The e-mail address for Avid DS Customer Support is: dssupport@avid.com.

You can use it for sending bug reports, usability questions, and avidds.cab 
audit reports for system analysis. All e-mails are logged in the support 
database and assigned a case number. Send one support request per e-mail.

n It is mandatory that you include your SID number in the body of your e-mail 
message for verification of your maintenance contract and case logging. 
Otherwise, response will be delayed.

Web Support

The Avid DS Support Center at http://www.softimage.com/avidds provides 
quick access to a wide range of resources from the Avid DS teams and user 
community. Downloads, including presets, drivers, and Quick Fix Engineering 
(QFE), provide the latest solutions for use with your Avid DS system. Online 
documentation, tutorials, and Knowledge Base articles ensure that you get the 
most out of your work with Avid DS. It's like having a dedicated Avid DS 
Customer Support engineer sitting at your desk!

Upload Utility

For troubleshooting purposes, you can upload your files for Avid DS 
Customer Support personnel to examine. You can upload a project's archive, 
media files, or other necessary data. Simply zip the files that you need to 
upload and use a short name (for easy retrieval), such as archive.zip or 
Case274877.zip. 

http://www.softimage.com/avidds
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To upload your files:

1. Go to the Avid web site at http://www.softimage.com/avidds.

2. Select Contact > Upload Tool.

3. Once the file upload is complete, send an e-mail to dssupport@avid.com 
to inform Avid DS Customer Support as there is no automatic notification 
when a file is uploaded on the FTP server. Please provide the complete 
and exact file name (case sensitive) to retrieve.

Avid Community Forum

Although the Avid DS community forum is frequently monitored by Avid 
employees, it is not part of the official support channels. You are invited to 
send your support requests to any of the above channels when required.

If you have an e-mail account, you can join the worldwide network of Avid DS 
users exchanging ideas. The mailing list has proven to be quite useful for 
users, and there is a constant stream of new subscribers. 

To subscribe, send an e-mail to majordomo@softimage.com with the 
following text in the body of your message: subscribe ds. You can get further 
information on using the automated list server by e-mailing 
majordomo@softimage.com with “help” as your message.

You can also join other Avid forums on the Avid web site at 
http://www.avid.com. Select Support > Forums.

http://www.softimage.com/avidds
http://www.avid.com
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Accessing the Online Library

The Online Library contains all the Avid DS Nitris documentation in PDF 
format. If it was installed on your system, you can access it from the Help 
menu in Avid DS Nitris.

n You will need Adobe® Acrobat® Reader® installed to view the documentation 
online.

To access the Online Library:

t In Avid DS Nitris, select Help > Online Library, 

or

t Insert the Software CD into your CD-ROM drive, and select Online 
Library from the main menu.

To install Adobe Acrobat Reader:

1. If Acrobat Reader is not installed on your system, insert the Drivers CD 
into your CD drive.

2. Under the Various section, select Utilities.

How to Order Documentation

To order additional copies of this documentation from within the 
United States, call Avid Sales at 800-949-AVID (800-949-2843). If you are 
placing an order from outside the United States, contact your local 
Avid representative.

Avid Educational Services

For information on courses/schedules, training centers, certifications, 
courseware, and books, please visit www.avid.com/training or call Avid Sales 
at 800-949-AVID (800-949-2843).



Chapter 1
Conforming AFE Files

Conforming is the process of bringing a project from an offline environment 
into Avid DS Nitris, so you can continue and finish the editing process. This 
chapter describes how to load an Avid File Exchange (AFE) file into 
Avid DS Nitris and recreate a sequence on which you can apply further edits 
and effects.

This chapter includes the following topics:

• Using AFE Files

• Workflow: Conforming AFE Files

• AFE Effects Support Table

• AFE Titles Support Table

• Conforming AAF Files

• Exporting AAF Files from Avid DS Nitris

• Conforming AAF Sequences with MediaManager

You can also conform OMF, EDL, and ALE files (see “Conforming OMF, 
EDL, and ALE Files” on page 75), but AFE files have a higher level of support 
for effects and titles.

n In this information, the general term “Avid editing system” refers to Avid 
applications other than Avid DS Nitris, such as Symphony™, 
Media Composer®, Film Composer®, Avid Xpress®, and NewsCutter®.
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Using AFE Files

Avid DS Nitris cannot directly open projects from Media Composer or other 
Avid editing systems. To transfer bins, clips, or sequences to Avid DS Nitris, 
you must use an intermediate file format. For the highest level of conform, use 
AFE (Avid File Exchange) files.

AFE files are based on AAF (Advanced Authoring Format) technology. AFE 
files, however, are designed especially for sharing information among Avid 
applications. AFE files let you transfer one or more bins, their contents, and 
information about the contents, including master clips, subclips, and 
sequences.

You must use AFE files if you are conforming from the following products:

• Media Composer Adrenaline™ v1.5 or later

• Avid Xpress Pro v4.5 or later

• Avid Xpress DV v4.5 or later

• NewsCutter Adrenaline FX v5.5 or later

• NewsCutter XP v5.5 or later

AAF files from earlier versions can still be used for conforming, but Avid 
recommends using AFE files. See “Conforming AAF Files” on page 67.
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Workflow: Conforming AFE Files

The following illustration shows the basic steps in the conform process using 
AFE files.

3

2

1

On an Avid DS Nitris 
system, open the AFE file 
in an Avid Explorer bin.

4Create a sequence 
and master clips.

Link to Avid Unity 
shared storage or 
recapture media.

Export an AFE file directly 
from the Avid editing 
system or through Avid 
MediaLog.

5 Finish and output 
the sequence.

Master

SourceSource

Avid Unity
shared 
storage
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Detailed information about these steps is included in the following sections:

• Before You Begin

• Step 1: Export AFE Files

• Step 2: Import AFE Files

• Step 3: Create a Sequence and Master Clips

• Step 4: Recapture Media

• Step 5: Finish the Conformed Sequence

Before You Begin

Proper planning results in a more efficient workflow. Ideally you can plan the 
project before the offline edit begins, but that’s not always possible. In any 
case, review the information in the following sections before you begin the 
conform process:

• Conforming HD Projects from Offline Sources

• Conforming HD Projects from HD Sources

• Conforming Effects

• Conforming Matte Keys and Alpha Channels

• Conforming AVX Plug-Ins

• Sharing and Transferring Files

• Preparing Audio Media

Depending on your workflow, review the following sections:

• “Transferring Audio Media” on page 44

• “Sharing Media” on page 47



Workflow: Conforming AFE Files

21

Conforming HD Projects from Offline Sources

To conform an HDTV (high-definition TV) project that was offlined on an 
Avid editing system, the offline sequence must be edited at the proper frame 
rate. The following table lists the required Avid editing project types for 
different HD formats and frame rates.

For information on working with audio, see “Using Audio from an Avid 
Editing System” on page 45.

For information on conforming projects using shared media (including 
DNxHD media), see “Sharing Media” on page 47.

You can also conform a project that was created in HD format on an Avid 
editing system that supports HD projects and media. See “Conforming HD 
Projects from HD Sources” on page 23.

If you need to convert the timecode of a sequence (for example, from 30 fps to 
24 fps, you can use the EDL Processor. See “EDL Processor” on page 92.

HD format
Avid DS Nitris project type Avid editing project type

1080i 50 fields/sec (25 fps) 25i PAL

1080i 60 fields/sec (30 fps) or 59.94 
fields/sec (29.97 fps)

30i NTSC

1080PsF 23.97 fps 24p NTSC

23.976p NTSC a

a. Requires Symphony 4.5 or later, Media Composer or Film Composer 11.5 or 
later, Media Composer Adrenaline 1.0 or later, Avid Xpress 5.5 or later, or Avid 
Xpress Pro 4.0 or later.

1080PsF 24 fps 24p NTSC or 24p PAL

1080PsF 25 fps 25i PAL

1080PsF 30 fps or 29.97 fps 30i NTSC

720p 60 fps or 59.94 fps 30i NTSC
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To conform an HD project from offline sources, follow this basic 
workflow:

1. Downconvert the HD source tapes to SD (standard-definition) tapes, using 
the 16:9 anamorphic aspect ratio.

For 24p sources, make sure the conversion uses non-drop-frame timecode 
and 2:3 pulldown, with the A frame at :00 or any frame that ends in 0 or 5 
(:05, :10, :15, and so on).

2. On an Avid editing system, create an offline project with the proper frame 
rate.

3. Capture the SD source tapes into the Avid editing system using an offline 
resolution. 

4. Edit the sequence.

5. (Optional if recapturing) On the Avid editing system, duplicate the 
finished sequence, copy the duplicate into a new bin, and decompose the 
duplicate. 

The Avid editing system creates new master clips that use only the media 
in the sequence, plus any handles you specify. These new clips are not 
linked to media, but are intended for recapture. You can delete the 
decomposed clips from the bin, because Avid DS Nitris recreates the clips 
during the conform process. For more information on decomposing, see 
the documentation for your Avid editing system.

6. Export an AFE file to recreate the sequence or project on the 
Avid DS Nitris system. Export directly from an Avid editing system or 
export through MediaLog, depending on the version of your Avid editing 
application. See “Step 1: Export AFE Files” on page 30.

7. On the Avid DS Nitris system, create a sequence with a frame rate that 
matches that of the source tapes.

8. Import the AFE file. See “Step 2: Import AFE Files” on page 38 and “Step 
3: Create a Sequence and Master Clips” on page 40.

9. Recapture the HD media on the Avid DS Nitris system. See “Step 4: 
Recapture Media” on page 44.

10. Finish and output the project. See “Step 5: Finish the Conformed 
Sequence” on page 44.
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Conforming HD Projects from HD Sources

To conform an HDTV project that was offlined on an Avid editing system 
using DNxHD media, make sure the offline sequence is edited at the proper 
format and frame rate. Media Composer Adrenaline HD and 
Avid Xpress Pro HD support the HD project formats described in the 
following table. This table also lists their equivalents in Avid DS Nitris.

For a list of shared DNxHD resolutions, see “Avid DNxHD Compressions” in 
the Help.

For information on working with audio, see “Using Audio from an Avid 
Editing System” on page 45.

The following procedure describes steps for conforming a project that requires 
recapture or HD media. For information on conforming projects using shared 
HD media, see “Sharing Media” on page 47.

HD format
Avid editing project type

HD format
Avid DS Nitris project type

720p/59.94 720p 59.94 fps

1080p/25 1080PsF 25 fps

1080p/23.976 1080PsF 23.97 fps

1080i/50 1080i 50 fields/sec

1080i/59.94 1080i 59.94 fields/sec
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To conform an HD project from HD sources, follow this basic workflow:

1. On an Avid editing system, create an offline project with the proper frame 
rate.

2. Capture the HD source tapes into the Avid editing system using a DNxHD 
resolution.

3. Edit the sequence.

4. (Optional if recapturing) On the Avid editing system, duplicate the 
finished sequence, copy the duplicate into a new bin, and decompose the 
duplicate. 

The Avid editing system creates new master clips that use only the media 
in the sequence, plus any handles you specify. These new clips are not 
linked to media, but are intended for recapture. You can delete the 
decomposed clips from the bin, because Avid DS Nitris recreates the clips 
during the conform process. For more information on decomposing, see 
the documentation for your Avid editing system.

5. Export an AFE file to recreate the sequence or project on the 
Avid DS Nitris system. Export directly from an Avid editing system or 
export through MediaLog, depending on the version of your Avid editing 
application. See “Step 1: Export AFE Files” on page 30.

6. On the Avid DS Nitris system, create a sequence with a format and frame 
rate that matches that of the offline project.

7. Import the AFE file. See “Step 2: Import AFE Files” on page 38 and “Step 
3: Create a Sequence and Master Clips” on page 40.

8. Recapture the HD media on the Avid DS Nitris system, as either DNxHD 
or uncompressed. See “Step 4: Recapture Media” on page 44.

9. Finish and output the project. See “Step 5: Finish the Conformed 
Sequence” on page 44.



Workflow: Conforming AFE Files

25

Conforming Effects

• Level of support: Be aware that not every effect in the original sequence 
will be completely conformed. For specific information, see “AFE Effects 
Support Table” on page 55, “AFE Titles Support Table” on page 62, and 
the Avid DS Nitris release notes. Also, during the conform process, you 
can view a log which lists any effects and parameters that are not 
supported.

• Titles: Place titles in the original sequence before you create an AFE file 
so that the title is conformed as part of the sequence. Avid DS Nitris does 
not conform titles as master clips. Titles promoted to 3D are not 
supported.

• Motion effects: Like titles, source-side motion effects are conformed only 
as part of a sequence.

The following points apply to Timewarp (record-side) motion effects:

- Timewarp effects that use speed ramp adjustments require the anchor 
frame to be on the first key value in order to conform correctly. If this 
is not the case, then the AAF/AFE Conform Log displays a message. 
To fix the effect in Avid DS Nitris, you need to adjust the Base Frame 
property accordingly.

- Timewarp effects with speed graphs from some older versions of Avid 
editing systems, such as Media Composer Adrenaline v1.5.1, do not 
conform. Timewarp effects from Media Composer Adrenaline HD 2.0 
conform correctly.

• Video levels: If the original sequence includes graphics that use video 
levels (ITU-R 601 levels, which include “SuperBlack” and 
“SuperWhite”), Avid DS Nitris preserves information about the video 
levels when creating master clips (through AFE files). When you 
recapture the graphics, Avid DS Nitris automatically recaptures them at 
the original levels. 

• Layered Photoshop graphics: Layered Photoshop graphics that have 
been imported as layers in the original sequence are not conformed 
correctly. You need to import the original layered graphic into 
Avid DS Nitris using the Generate > Import Photoshop command.

• Audio effects: Audio pan, Audio EQ, and AudioSuite plug-ins are not 
conformed. In the original sequence, you can mix down the areas that 
contain these adjustments or effects and then output an audio mix—see 
“Transferring Audio Media” on page 44.
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• Color Correction: Color corrections made in Color Correction mode 
with the Symphony Color Correction tool are not conformed. For color 
corrections to be conformed, you must apply the Color Correction effect 
from the Effect Palette, as described in the Avid Symphony Color 
Correction Guide. This problem does not occur if you use the Avid Color 
Correction tool (available with Avid editing products other than 
Symphony). 

Secondary color correction is not conformed.

In Avid Symphony, the gamma is applied in RGB space between the 
superblack and superwhite range while in Avid DS Nitris, the RGB 
gamma is applied between the black and white range. Therefore, there is a 
small discrepancy in conform when conforming color corrected sequences 
from Avid Symphony with applied HSL gamma, particularly for gamma 
values close to 0 or much larger than 1.

• Multi-cam: Multi-cam groups are not conformed. Only the selected clip 
is conformed.

• Foreground level and effects on V1: Avid DS Nitris always displays 
images on video track V1 as completely opaque and ignores any setting to 
Foreground Level (Opacity in Avid DS Nitris). On the Avid editing 
system, add Generated Black (created through the Title Tool or as an 
imported graphic) beneath any effects that use Level in this manner.

• Effects applied to filler: Color Correction and Pan and Scan applied to 
filler on the top track of the original sequence are conformed correctly in 
Avid DS Nitris, but other effects are not. Clips on lower tracks are not 
affected by the effect applied to the filler. For example, if a Color Effect is 
applied to filler on V2 and used to desaturate all the clips beneath it on 
V1, none of the clips will be desaturated when the sequence is conformed.

On the Avid editing system, always apply effects directly to a clip or use 
nesting to apply an effect to multiple clips.

• Avid DS Nitris Editor systems: Avid DS Nitris Editor systems cannot 
open composite containers for editing. If a sequence is going to be 
conformed on an Avid DS Nitris Editor system, avoid using effect 
constructions that are conformed as composite containers, such as multi-
track Submasters or Matte Keys that include a nested background.

• Soft Cuts and Short Transitions: Most Avid editing systems use a 
special interpolation for transitions to provide support for soft cuts and 
very short transitions (such as a four-frame dissolve). Avid DS Nitris does 
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not yet support this type of interpolation, so these transitions will not 
conform totally and might require some adjustment after the conform 
process.

Conforming Matte Keys and Alpha Channels

• Matte Key clips: Place matte keys in the original sequence before you 
create an AFE file so that the matte key is conformed as part of the 
sequence. Avid DS Nitris does not conform matte keys as master clips.

• Traditional matte keys (Matte Key effect): On the Avid editing system, 
Foreground (fill) and Matte elements must be nested inside the Matte Key 
effect or the effect will not be conformed correctly. Use the Collapse 
function on the fill and matte before you apply the Matte Key effect. Then 
replace the Submaster effect with a Matte Key effect.

Matte Key effects are conformed as Matte containers. If the fill and matte 
were not nested on the Avid editing system, you can fix the problem in 
Avid DS Nitris by cutting the fill element and pasting it into the container.

For more information, see “Working with Mattes” in the Help.

• Imported matte keys: Matte keys created from still graphics and 
imported to an Avid editing system are conformed as Matte containers 
with all parameters intact. 

However, imported graphics promoted to 3D Matte Keys are not 
conformed. Avid DS Nitris replaces the 3D Matte Key as a DVE within a 
Composite container without the original effect parameters. To set up the 
matte key correctly:

- Open the composite container.

- In Layers View, marry the fill and matte by dragging the matte to the 
fill layer.

- Invert the alpha channel.

- Delete the old matte layer and the DVE effect on the alpha channel.

- Apply a Layer DVE inside the container or a DVE clip to the outside 
and recreate any animation.

• QuickTime movies: Imported QuickTime movies with alpha are not 
conformed correctly. You need to manually invert the alpha channel using 
the Avid DS Nitris Matte container properties.

• Sequential file formats: Sequential file formats with alpha channels that 
have been imported to an Avid editing system are now conformed 
correctly.
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Conforming AVX Plug-Ins

• Avid DS Nitris currently supports only AVX® 1.0 plug-ins.  For 
information about support for Avid AVX plug-ins see the “AFE Effects 
Support Table” on page 55. For information about third-party plug-ins, 
see the AVX web page at www.avid.com/partners/avx.

• If you need to share an AVX plug-in, make sure the same plug-in is 
installed on both systems. On the Avid DS Nitris system, the default path 
is drive:\Program Files\Avid\AVX_Plug-ins. 

Sharing and Transferring Files

• Media Composer Macintosh systems, and other Macintosh-based Avid 
editors, cannot use MXF media created by Avid DS Nitris, due to a 31-
character file name limit. This situation occurs when an Avid DS Nitris 
system creates a storage on a Unity volume to share with other Avid 
editing systems. This problem does not affect Windows systems.

• If you are conforming a sequence that includes still graphics, the graphics 
will link automatically if you copy them to a folder in the same path as the 
folder used in the offline edit. For example, if the offline sequence 
includes graphics imported from a folder named Graphics at the top level 
of drive D (D:\Graphics), create a folder named D:\Graphics on the online 
editing system and copy the graphics to it.

• You must conform a drop-frame (DF) sequence in an Avid DS Nitris 
drop-frame sequence and a non-drop-frame (NDF) sequence in a non-
drop-frame sequence. For example, if you drag a drop-frame sequence 
into a non-drop-frame sequence, the sequence will be conformed as a non-
drop frame sequence. You can change the timeline display from NDF to 
DF or from DF to NDF in the Sequence Preferences dialog box. 

• If you are conforming a sequence from an AFE file by holding down the 
U key and dragging the sequence to an opened sequence, the starting 
timecode of the sequence you are conforming must be later than the 
starting timecode of the opened sequence. Otherwise the sequence you are 
conforming will use the starting timecode of the opened sequence. For 
example, if a Media Composer sequence starts at 00:00:00:00 and an 
opened Avid DS Nitris sequence starts at 01:00:00:00, the conformed 
Media Composer sequence will start at 01:00:00:00.

Workaround: Conform the sequence to an Avid Explorer bin and then 
edit it as required.

http://www.avid.com/partners/avx
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• If you are conforming a clip or sequence captured from a BWF (Broadcast 
Wave Format) source, Avid DS Nitris marks the master clip as a tape 
source. As a result, you cannot recapture media from the source BWF file. 

To work around this problem, do one of the following:

- Directly relink to the original media through shared storage

- Import the media from an OMF file containing embedded media.

- On the Avid editing system, transfer the media to tape. On the 
Avid DS Nitris system, recapture the media from that tape.

However, you cannot relink to BWF .aif media nor can you import an 
OMF file containing BWF .aif or .mxf media captured in one of the 
following products:

- Media Composer Adrenaline 

- Avid Xpress Pro

- Avid Xpress DV

- NewsCutter Adrenaline FX

- NewsCutter XP 

For these products, relink to .wav or .mxf media, or import an OMF file 
with embedded .wav media.

• To make it easier to move files between products and across platforms, 
use the following guidelines when naming files:

- Do not use the following characters in project, bin, or other file 
names: / \ : * ? ” < > | 

The Windows system does not recognize these characters in file 
names and will substitute other characters, possibly making the file 
name unrecognizable or causing other problems.

- Do not add spaces at the beginning or end of a file name. The 
Windows system will display such files, but might be unable to open 
them.

- Do not use a period at the end of a file name. The Windows system 
will display such files, but might be unable to open them.

- On Avid Macintosh systems, you can enable a setting that prevents 
you from using Windows restricted characters in file names and 
automatically adds the correct file name extensions to files for your 
project. When you select the Use Windows Compatible File Names 
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setting, the file name extension .avp is added to project files and .avb 
is added to bin files when they are saved. These file name extensions 
are attached to existing files as well.

• If the project includes titles and you are moving between Macintosh and 
Windows systems, make sure you have the same font with exactly the 
same name (preferably from the same manufacturer) on both the 
Macintosh and Windows systems. Check the font carefully because the 
same font can have slightly different names. For example, Times New 
Roman on the Macintosh system is named Times New Roman Regular on 
the Windows system.

In some cases, you might need to convert the Macintosh font to a 
Windows font by using a font conversion program.

For information on how Avid DS Nitris substitutes title fonts, see “Font 
Substitution for Titles” on page 65.

For best results, use TrueType or PostScript fonts. Bitmap fonts can cause 
scaling problems.

Preparing Audio Media

Instead of recapturing or linking to audio media, you can capture or import an 
audio mix. For more information, see “Transferring Audio Media” on page 44.

Step 1: Export AFE Files

AFE files are the preferred method of conforming sequences created on other 
Avid editing systems.(see “Using AFE Files” on page 18). You can create 
AFE files from the following products (Windows versions only):

• Symphony 4.5 and later

• Media Composer or Film Composer 11.5 and later

• Media Composer Adrenaline 1.0 and later

• Avid Xpress 5.5 and later
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• Avid Xpress DV 4.1 and later

• Avid Xpress Pro 4.0 and later

• NewsCutter and NewsCutter XP 5.5 and later

• NewsCutter Adrenaline FX 5.0 and later

• Avid MediaLog 11.1 and later. You can use MediaLog on either the Avid 
editing system or the Avid DS Nitris system.

You cannot create AFE files from the Macintosh version of these products. To 
create an AFE file from an Avid editing product running on a Macintosh 
system, copy the project folder from the Macintosh system to the 
Avid DS Nitris system. Then use MediaLog on the Avid DS Nitris system to 
create the AFE file. A project folder has the same name as the project, and is 
usually located in the Avid Projects folder on the Macintosh HD. For 
information about the location of project folders, see the documentation for 
your Avid editing system.

n MediaLog is shipped with your Avid DS Nitris system. For complete 
information about MediaLog, see the MediaLog Help or the Avid MediaLog 
User’s Guide (available in Adobe Acrobat format on the MediaLog CD). 
MediaLog is also available in the Download area of the Avid DS Nitris 
Customer Support web site (http://www.softimage.com/avidds).

MediaLog 20.x and 21.1 do not support 24p PAL and 25p PAL projects. For 
these projects, use MediaLog 21.3 or later, which is available for download.

Avid DS Nitris supports bins, through AFE files, that originated from the 
following Avid editing products:

• Symphony 4.0 and later

• Media Composer and Film Composer 11.0 and later

• Media Composer Adrenaline 1.0 and later

• Avid Xpress 5.0 and later

• Avid Xpress DV 3.0 and later

• Avid Xpress Pro 4.0 and later

• NewsCutter and NewsCutter XP 3.0 and later

• NewsCutter Adrenaline FX 5.0 and later

http://www.softimage.com/avidds
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Avid DS Nitris supports projects and bins, through AFE files, that originated 
from the following Avid editing products. However, these products have not 
been fully qualified and sequences might not conform completely:

• Symphony 2.1 through 3.6

• Media Composer and Film Composer (Macintosh) 7.2 through 10.6

• Media Composer and Film Composer (Windows) 9.1 through 10.6

• Avid Xpress (Macintosh) 2.1 through 4.6

• Avid Xpress (Windows) 3.1 through 4.6

• Avid Xpress DV 1.0 through 2.1

• NewsCutter and NewsCutter XP 1.5 through 2.6

For information about effects and titles, refer to the “AFE Effects Support 
Table” on page 55 and “AFE Titles Support Table” on page 62.

Exporting AFE Files from an Avid Editing System

To export an AFE file from an Avid editing system:

1. (Optional if planning to recapture) On the Avid editing system, duplicate 
the finished sequence, copy the duplicate into a new bin, and decompose 
the duplicate. 

The Avid editing system creates new master clips that use only the media 
in the sequence, plus any handles you specify. These new clips are not 
linked to media, but are intended for recapture. You can delete the 
decomposed clips from the bin, because Avid DS Nitris recreates the clips 
during the conform process. For more information on decomposing, see 
the documentation for your Avid editing system.
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2. Do one of the following:

t To create a file that includes all bins in a project, click the Project 
window and select File > Export. The Export Project As dialog box 
opens. Select a location, name the file, and click the Save button.

t To create a file that includes the contents of a single bin, open the bin, 
click the bin, and select File > Export. (Make sure no objects in the 
bin are selected.) The Export Bin As dialog box appears. Select Avid 
File Exchange (*.afe) from the “Export Bin As” list. Choose a 
location, name the file, and click the Save button.
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t To create a file that contains a clip or sequence, select the clip or 
sequence and then select File > Send To > Avid DS.

You cannot change options for this export, so click OK. The resulting file 
includes the source bin as well as the object you chose, but does not 
include other objects that might be in the bin.

n The Send To command creates AFE files in the following products only:

• Media Composer Adrenaline v1.5 or later

• Avid Xpress Pro v4.5 or later

• Avid Xpress DV v4.5 or later

• NewsCutter Adrenaline FX v5.5 or later

• NewsCutter XP v5.5 or later

Earlier versions create AAF files. See “Conforming AAF Files” on page 67.



Workflow: Conforming AFE Files

35

3. Transfer the AFE file to a location that you can access from the 
Avid DS Nitris workstation.

You can use removable media, a network server, or an Avid Unity shared 
storage system.

Exporting AFE Files from MediaLog

You can run MediaLog on the Avid editing system or on the Avid DS Nitris 
system. You can export AFE files only from the Windows version of 
MediaLog. For more information, see “Step 1: Export AFE Files” on page 30.

n MediaLog is shipped with your Avid DS Nitris system. For complete 
information about MediaLog, see the MediaLog Help or the Avid MediaLog 
User’s Guide (available in Adobe Acrobat format on the MediaLog CD). 
MediaLog is also available in the Download area of the Avid DS Nitris 
Customer Support web site (http://www.softimage.com/avidds).

To export an AFE file from MediaLog v20.x or later:

1. (Optional if planning to recapture) On the Avid editing system, duplicate 
the finished sequence, copy the duplicate into a new bin, and decompose 
the duplicate. For more information on decomposing, see the 
documentation for your Avid editing system.

2. If you plan to run MediaLog on an Avid editing system, close the Avid 
editing application.

3. If you plan to run MediaLog on an Avid DS Nitris system, transfer the 
Avid editing project folder to the \MediaLog\Avid Projects folder on the 
Avid DS Nitris workstation or to an Avid Unity workspace. A project 
folder has the same name as the project, and is usually located in the Avid 
Projects folder on the Avid editing system. Alternatively, copy a single 
bin, then create a new project and add the bin. Bins are located in the 
project folder.

For information about the location of project folders, see the 
documentation for your Avid editing system.

4. Open MediaLog by double-clicking the desktop icon or selecting Start > 
Programs > Avid > Avid MediaLog.

c Do not share user settings between MediaLog and the Avid 
editing system. The settings might become corrupted.

http://www.softimage.com/avidds
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The Select Project dialog box opens.

The user and user settings are determined by the system login. If the 
project does not appear in the project list, use the Browse button to 
navigate to the project you want to transfer. Select the project and click 
OK.

5. In the Select Project dialog box, select the project and click OK.

The project opens.

Browse button

Project window Bin
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6. Do one of the following:

- To create a file that includes all bins in a project, click the project 
window and select File > Export. The Export Project As dialog box 
opens. Select a location and click the Save button.

- To create a file that includes the contents of a single bin, open the bin, 
click the bin (make sure no objects in the bin are selected), and select 
File > Export. Select AFE from the dialog box. In the Export Bin As 
dialog box, choose a location and click the Save button.

- To create a file that includes selected objects, open the bin, select the 
objects you want to include in the file, and select File > Export. 
Select AFE from the dialog box. In the Export As dialog box, choose 
a location, name the file, and click the Save button.

MediaLog creates an AFE file.

c Make sure to close MediaLog before opening Avid DS Nitris. If MediaLog 
and Avid DS Nitris are open at the same time, Avid DS Nitris 
performance is seriously affected.

n AFE export to a network drive takes much longer than export to a local drive. 
Avid recommends that you export to a local drive and then copy the exported 
file to a network location.

7. If you are running MediaLog on an Avid editing system, make sure the 
AFE file is in a location that you can access from the Avid DS Nitris 
workstation.

You can use removable media, a network server, or an Avid Unity shared 
storage system.

n If you open a project in an Avid editing system after you have created an AFE 
file from the project, the following message might appear: An incompatible (or 
damaged) setting has been skipped. The original project should not be 
affected.
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Transferring Media

If you are using a removable drive to share media, disconnect the drive from 
the offline system and connect it to the Avid DS Nitris system. For 
information on connecting and disconnecting an external media drive, refer to 
your system setup guide.

Step 2: Import AFE Files

After you have determined the location of the transferred file, you can import 
it into Avid DS Nitris.

To import an AFE file:

1. Create an Avid DS Nitris project and sequence.

2. Use the Avid Explorer to select the folder that holds the AAF or AFE file.

The file opens in the AAF/AFE View.

AFE file
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3. Double-click the file.

The imported bin or bins are displayed.

4. Double-click an imported bin to display its contents.

The contents can include master clips, subclips, and sequences. For a 
description of Avid editing system icons, see “AAF/AFE List” in the 
Help.

Imported bin

Audio clip

Master clips

Sequence
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The columns initially displayed match the columns displayed when the 
AFE file was created. You can show additional columns or hide selected 
columns, as described in “Customizing the Details and Script Views” in 
the Help.

n Bin columns from AFE files are not associated with new Avid DS Nitris master 
clips.

At this point, you haven’t yet created an Avid DS Nitris sequence or master 
clips. 

Step 3: Create a Sequence and Master Clips

After you have imported the AFE file, you can drag a sequence onto the 
timeline and create master clips that are associated with the sequence. You can 
also create master clips by dragging an imported clip or sequence to a bin or 
by dragging one or more bins to a folder.

To create a sequence and master clips:

1. If the AAF/AFE settings are not displayed, click the AAF/AFE Settings 
button.

AAF/AFE Settings button

AAF/AFE 
settings
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2. In the AAF/AFE settings, select the Create Associated Clips option.

Select this option if you want to create master clips by dragging an 
imported clip or sequence to the timeline.

Deselect this option if you have already created master clips and you want 
to avoid creating a duplicate set. Duplicate clips are marked by the 
addition of a sequential number (001, 002, and so on).

3. To append the original project name to the master clip source names when 
creating master clips, select the Force Creation of External Tape 
Sources option. This option distinguishes between clips that are created 
from tapes associated with the conform and clips that are not. Selecting 
this option does not prevent you from linking to shared media files or 
recapturing from the source tape.

For example, if you are conforming an AFE created on another Avid 
system and you want Avid DS Nitris to link to the media captured by that 
system, or recaptured media from the source tapes, select this option. If 
you are conforming an AFE and you want Avid DS Nitris to link to media 
that you have already captured (such as through an ALE file), do not 
select this option.

4. (Option) To create linked clips, select Create Linked Clips for File 
Sources.

For information about linked clips, see “Creating Linked Clips” in the 
Help.

5. Specify the path for the folder in which you want to create the master clips 
after you drag a clip or sequence to the timeline. Click the browse (...) 
button to navigate to the folder.

Avid DS Nitris checks the path to make sure the folder is within the 
project folder.

6. To keep the same folder for any new master clips you create, select the 
Lock Path option. Deselect this option to create master clips in folders that 
match the names of the imported bins. Deselecting this option lets you 
keep the original project structure when you conform with AFE files.

7. Open a new sequence in your project. Make sure the frame rate matches 
that of the original project (see “Conforming HD Projects from Offline 
Sources” on page 21).
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8. Do one of the following:

t Create or open a sequence and drag a clip or sequence from the 
AAF/AFE View onto the timeline. To match the timecode of the 
imported sequence to the timecode of the sequence in the timeline, 
hold down the U key while you drag the sequence to the timeline.

t Drag clips or sequences, or both, from the AAF/AFE View into a bin.

t Drag one or more bins from the AAF/AFE View into a folder.

The conform process begins. Depending on the length of the sequence or 
the number of items, a progress bar is displayed.

When the conform is complete, the sequence, its clips, and supported 
effects are recreated in Avid DS Nitris. Titles are recreated only if they are 
part of the sequence.

If you are sharing media, the clips are automatically linked. 

If you are recapturing media, empty master clips are created in the folder 
that you have specified. When you open the folder in a bin, the clip icons 
are red since no media has been captured yet. 

A message box displays a summary of the information contained in the 
AAF/AFE Conform Log and asks if you want to view the log.

9. To view the AAF/AFE Conform Log, click Yes.

The AAF/AFE Conform Log window displays information about how the 
effects and parameters were supported. Use this information to finish the 
final sequence.
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10. To save the log as an .html file, click the Save button. 

The Save As dialog box opens.

11. Navigate to an appropriate folder, type in a name for the log, and click the 
Save button. Click OK to close the log window. 

12. Save the sequence.
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Step 4: Recapture Media

If you are not sharing media, you need to recapture media for the empty 
master clips. For more information, see “Batch Capturing” in the 
Avid DS Nitris Capture and Output Guide or the Help.

Step 5: Finish the Conformed Sequence

Depending on the number and types of effects, you may need to process or 
recreate effects. Refer to the AAF/AFE Conform Log as you review the 
sequence. Also refer to the “AFE Effects Support Table” on page 55 and the 
“AFE Titles Support Table” on page 62.

Transferring Audio Media

Instead of recapturing and editing audio media, you can capture or import an 
audio mix.

Possible workflows are:

• Creating a digital cut of the final audio mix in Media Composer (or other 
Avid editing system) and capturing the audio in Avid DS Nitris.

• Exporting an OMF file with embedded audio media from an Avid editing 
system and importing it into Avid DS Nitris.
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Using Audio from an Avid Editing System

If you want to use audio from Media Composer (or another Avid editing 
system) in the final sequence, make sure the frame rates match the frame rates 
on the Avid DS Nitris system. To transfer the audio, you can perform a digital 
cut and capture audio from tape or, in most cases, you can use OMF. Refer to 
the following table for more specific information:

If the frame rate of the audio doesn’t match the frame rate of your sequence, 
you can change the frame rate by using the Media Tool.

For example, if you are converting a sequence from true 24 fps to 23.976 fps 
(NTSC), you need to adjust the frame rate of the audio clips, so that they 
remain in sync with the video. The sample rate of the audio clips will remain 
the same but they will now be slightly longer or shorter to remain in sync. For 
more information, see  “Converting the Reference Frame Rate of Audio Clips” 
in the Help.

Avid editor project
Digital cut 
output format

OK to 
use 
OMF?

Avid DS Nitris 
format

30i NTSC (29.97 fps frame rate) Standard NTSC Yes NTSC (29.97 fps) 

25i PAL (25 fps frame rate) Standard PAL Yes PAL (25 fps)

24p NTSC (24 fps frame rate) 24 (NTSC)
Destination TC 
rate depends on 
output device.

Yes 1080 PsF, 24 fps

24p NTSC (24 fps frame rate) 23.976 (NTSC) Noa 1080 PsF, 23.97 fps

23.976p NTSCb 23.976 (NTSC) Yes 1080 PsF, 23.97

24p PAL 24 (PAL) Yes 1080 PsF, 24 fps

a. See the article “How to Reduce the Audio Play Rate from 24 fps to 23.976” in the 
Avid DS Nitris Customer Support Knowledge Base (Previous Releases section)

b. Requires Symphony 4.5 or later, Media Composer or 
Film Composer 11.5 or later, Media Composer Adrenaline 1.0 or later, Avid Xpress 5.5 
or later, or Avid Xpress Pro 4.0 or later.
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Exporting and Importing OMF Audio

The following procedure outlines the workflow for exporting audio as an OMF 
file from an offline Avid editing system, transferring the audio to 
Avid DS Nitris, and importing the audio to Avid DS Nitris.

To export and import audio as an OMF file:

1. Make sure the project frame rates match—see “Using Audio from an Avid 
Editing System” on page 45.

2. On Media Composer or another Avid editing system:

t Export a sequence, project, or bins as an AFE file

t Export the audio track as an OMF file (composition and audio media)

If you are transferring the audio to Avid DS Nitris, embed the audio media 
and export it as OMF 2.0.

For more information on creating an OMF file, see the Help or the 
documentation for the Avid editing system.

3. Transfer the OMF file to the Avid DS Nitris workstation and import.

For more information, see “Conforming an OMF File” on page 78.

4. Create a new sequence and conform the OMF file.

n Conforming an OMF file requires a new sequence, so conform the OMF file 
before conforming the AFE file.

n OMF files that are exported at a frame rate must be conformed in the timeline. 
OMF files that are exported as sample-accurate must be conformed in an 
audio container. 

5. Conform the AFE file by dragging the sequence from a bin to the 
timeline. 

6. Batch capture the video media. Optionally, capture the audio if you want 
to use it for a scratch track.

7. Sync the sweetened sound. 

8. (Optional) Delete the audio scratch track.
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Sharing Media

Avid DS Nitris can share compressed and uncompressed media with other 
Avid editing systems. You can share media by using AFE files and Avid 
Unity™ MediaNetwork shared storage. You can also transfer media files over a 
network or by using removable SCSI drives.

Avid editing systems can share two media formats:

• MXF: Avid DS Nitris can link to MXF files and play them in real time. It 
can also create and modify MXF files and share them with other Avid 
editing systems. See “Sharing MXF Media” on page 49 and “Sharing HD 
Media” on page 50.

• OMFI: Avid DS Nitris can link to OMFI files and play them in real time. 
The storage that holds the media must be configured as “None” (read-
only) in the Avid Media Storage dialog box. Avid DS Nitris cannot create 
OMFI files.

The following tables list how Avid DS Nitris supports the shared media 
formats. Avid DS Nitris can relink to all formats through AFE files and play 
the media in real-time (RT).

MXF Compression Capture Import
(source)

Export Relink

DNxHD (all 8-bit and 
10-bit compressions)a

a. Requires Avid DS Nitris v7.5 QFE 3

RT Yes Yes RT

1:1 (uncompressed 8-bit 
and 10-bit)b

b. Requires Avid DS Nitris v7.5 QFE 3 for uncompressed 10-bit.

RT Yes Yes RT

2:1, 3:1, 10:1, 20:1
(JFIF interlaced)

RT Yes Yes RT

2:1s, 4:1s, 15:1s
(JFIF single-field)

No Yes Yes RT

DV 25 No Yes Yes RT

DV 50 No Yes Yes RT

DVCPRO HD No No No No

MPEG2 IMX (30, 40, 50) No Yes Yes RT
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Avid DS Nitris can also share the following audio formats:

• 48k/16 bit, 48k/24 bit

• 44.1k/16 bit, 44.1k/24 bit

• 32k/16 bit, 32k/24 bit

Avid DS Nitris does not support the following formats: 

• Progressive resolutions

• Multicamera resolutions

• AVR resolutions.

You cannot share caches or precomputes between Avid DS Nitris and other 
Avid editing systems.

Note the following:

• If you are sharing media on an Avid Unity MediaNetwork workspace, 
make sure that both the offline and the online systems have access to the 
workspace. 

• If you are transferring files on a removable SCSI drive or drives, make 
sure that you can correctly transfer the drives. For information on 
disconnecting and connecting removable drives, refer to your system 
setup guide and operating system help.

OMFI Compression Capture
Import
(source) Export Relink

1:1 (uncompressed) No Yes No RT

2:1, 3:1, 10:1, 20:1
(JFIF interlaced)

No Yes No RT

2:1s, 4:1s, 15:1s
(JFIF single-field)

No Yes No RT

DV25 No Yes No RT

DV50 No Yes No RT

MPEG2 IMX (30, 40, 50) No Yes No RT
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• If you are copying files to a local drive (one already attached to your 
Avid DS Nitris system) or a drive you can access through the Media 
Indexer, locate or create a folder named OMFI MediaFiles (for OMFI 
files) or Avid MediaFiles (for MXF files) on the drive. 

This folder name must use the correct uppercase and lowercase letters and 
include a space between OMFI and MediaFiles or between Avid and 
MediaFiles. For more information about folders for MXF storage, see 
“Sharing MXF Media” on page 49.

• If you are linking to media that does not match the compression of the 
sequence (for example, if you are linking to DV25 in an uncompressed 
sequence), make sure to set the option “Use the Closest Media Available” 
in the Sequence Preferences dialog box.

For information about how to set up storage, see “Managing Your Storage 
Areas” in the Avid DS Nitris Installation and Administration Guide or the 
Help.

Sharing MXF Media

MXF (Material Exchange Format) is an industry-standard container format 
that encapsulates media and production metadata into a single file. MXF is 
supported as a native file format on Avid DS Nitris, Media Composer, and 
other Avid applications (in addition to .gen files on Avid DS Nitris and .omfi 
files on other Avid applications). MXF support provides a common file format 
for direct media interchange among Avid applications, as well as with third-
party MXF-compliant products. MXF supports both standard-definition and 
high-definition formats (see “Step 1: Export AFE Files” on page 30 and 
“Sharing HD Media” on page 50). 

Avid DS Nitris also supports MXF as a file format for import and export.

The following applications can create, play, output, and share MXF files:

• Avid DS Nitris v7.5 and later

• Media Composer Adrenaline v1.5 and later

• Avid Xpress Pro v4.5 and later

• Avid Xpress DV v4.5 and later

• NewsCutter Adrenaline FX v5.5 and later

• NewsCutter XP v5.5 and later
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n MediaManager does not support MXF files.

Sharing HD Media

Avid DS Nitris can share HD projects and Avid DNxHD media with 
Media Composer Adrenaline HD systems. DNxHD media is an MXF media 
format created by Avid to deliver mastering-quality HD media at standard-
definition data rates and file sizes. To share this media, you must be running 
Avid DS Nitris v7.5 QFE 3 or later, which is available from the Avid DS 
Support Center (www.softimage.com/avidds). 

This version of Avid DS Nitris lets you share DNxHD media captured on 
Media Composer Adrenaline HD systems, and lets Media Composer 
Adrenaline HD systems share DNxHD media captured on Avid DS Nitris 
systems. Avid Xpress Pro HD systems can also share this media, but cannot 
capture it.

For a list of shared DNxHD resolutions, see “Avid DNxHD Compressions” in 
the Help.

For a list of compatible project formats, see “Conforming HD Projects from 
HD Sources” on page 23. 

Configuring Storages for Sharing MXF Files

Before you share MXF files, you need to configure the storages correctly in 
Avid DS Nitris. Avid DS Nitris requires separate storage areas (one for audio 
and one for video) to write MXF media. By default, other Avid editing 
systems create a single folder for MXF media, named Avid MediaFiles\MXF, 
and can write both audio and video files to the same folder.

http://www.softimage.com/avidds
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To share MXF media between Avid DS Nitris and other Avid editing systems, 
create correctly named folders and configure them in the Avid DS Nitris 
Media Storage Configuration tool, as described in the following table:

n Avid DS Nitris and other Avid editing systems can link to MXF media in the 
same shared folder but cannot create MXF media in the same shared folder. 

On an Avid Unity MediaNetwork, create and configure the following folders:

\\server_name\workspace_name\Avid MediaFiles\MXF
\\server_name\workspace_name\Avid MediaFiles\VideoStorage
\\server_name\workspace_name\Avid MediaFiles\AudioStorage

Make sure to use the correct syntax:

• Include a space between Avid and MediaFiles

• Don’t include a space for MediaFiles, VideoStorage, and AudioStorage

• Use the correct uppercase and lowercase letters.

For more information on configuring storage, see “Configuring Storage for 
your Workstation” in the Avid DS Nitris Installation and Administration Guide 
or the Help.

Folder Description

Type of configuration in 
Media Storage 
Configuration tool

\Avid MediaFiles\MXF Where Media Composer and other Avid 
editing systems write MXF video and 
audio files so that Avid DS Nitris can link 
to them.

Read-only

\Avid MediaFiles\Video Storage Where Avid DS Nitris writes MXF video 
files so that other Avid editing systems can 
link to them.

MXF video files

\Avid MediaFiles\Audio Storage Where Avid DS Nitris writes MXF audio 
files so that other Avid editing systems can 
link to them.

MXF audio files 
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Conforming an MXF Sequence Created on Another Avid Editing System

In this workflow, a Media Composer or other Avid editing system creates 
MXF files, and Avid DS Nitris links to those files.

To conform an MXF sequence created on another Avid editing system, 
follow this basic workflow:

1. Make sure any storage devices or Avid Unity MediaNetwork workspaces 
are configured correctly. For more information on configuring storage, see 
“Configuring Storage for your Workstation” in the Avid DS Nitris 
Installation and Administration Guide or the Help.

2. On the Avid editing system, create a project and capture the source 
footage in MXF format at a supported resolution.

Alternatively, you can capture in OMFI format and later use the Transcode 
feature to convert the media into MXF format.

3. Edit the sequence.

4. Export an AFE file to recreate the project or sequence on the 
Avid DS Nitris system. Export directly from an Avid editing system or 
export through MediaLog, depending on the version of your Avid editing 
application. See “Step 1: Export AFE Files” on page 30.

5. If you are transferring media, rather than sharing in an Avid Unity 
environment, do one of the following:

t If you are transferring media to Avid DS Nitris over a network, copy 
the \Avid MediaFiles\MXF folder to a folder to a local drive. 
Alternatively, copy audio files to an MXF audio storage and copy 
video files to an MXF video storage. Configure the storages if 
necessary. 

t If you are transferring media on a removable drive, connect the drive 
and configure the new storage.

6. Import the AFE file. See “Step 2: Import AFE Files” on page 38

7. Create Avid DS sequences and clip. See “Step 3: Create a Sequence and 
Master Clips” on page 40.

The sequences and clips automatically link to the media.

8. Finish and output the project. See “Step 5: Finish the Conformed 
Sequence” on page 44.



Workflow: Conforming AFE Files

53

Sharing Media Captured on Avid DS Nitris

You can share MXF master clips captured on Avid DS Nitris with other Avid 
editing systems. You can share MXF HD (DNxHD) media only with other 
systems that support MXF HD media

To share MXF master clips created on Avid DS Nitris, follow this basic 
workflow:

1. Make sure any storage devices or Unity MediaNetwork workspaces are 
configured correctly. See “Configuring Storages for Sharing MXF Files” 
on page 50

2. On the Avid DS Nitris system:

a. Create a project. In the New Sequence dialog box, select the proper 
capture settings: MXF storages (one for audio and one for video), 
desired compression, and so on. MXF storage can be shared (in an 
Avid Unity environment) or local (and later transferred).

n If you are going to capture audio from a multi-stream file, make sure to select 
the option “Import audio into separate audio tracks” in the New Sequence 
dialog box. For more information, see “Capturing Audio as Separate Mono 
Tracks” on page 55.

b. Capture and edit the media.

c. Export an AAF file (see “Exporting AAF Files from Avid DS Nitris” 
on page 68).

3. If you are transferring media to the Avid editing system, rather than 
sharing in an Avid Unity environment, do one of the following:

t If you are transferring media over a network, copy the MXF audio 
storage and the MXF video storage to the local drive.

t If you are transferring media on a removable drive, connect the drive. 

4. On the Avid editing system, open a project with a matching frame rate.

5. Import one or more AAF files.

The Avid editing system creates a master clip for each AAF file.
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6. Select the new master clips and select Clip > Relink.

The Relink dialog box opens.

7. Deselect the option “Relink only to media from the current project,” 
accept the other defaults, and click OK.

The master clips are relinked with the MXF media.

n You can use the Media Tool to create master clips, but this method does not 
always work, for example, when a clip from Avid DS Nitris includes alpha.

n Media Composer Macintosh systems, and other Macintosh-based Avid editors, 
cannot use MXF media created by Avid DS Nitris, due to a 31-character file 
name limit. This situation occurs when an Avid DS Nitris system creates a 
storage on a Unity volume to share with other Avid editing systems. This 
problem does not affect Windows systems.
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Capturing Audio as Separate Mono Tracks

By default, Avid DS Nitris creates a single .wav or MXF file and track from a 
multi-stream audio file. This is the most efficient way to work with audio files 
in Avid DS Nitris. However, other Avid applications cannot link to a multi-
stream file. If you are capturing multi-stream audio to share with other Avid 
editing applications, you need to select the “Import audio into separate audio 
tracks” option. Selecting this option causes Avid DS Nitris to create multiple 
single-stream files.

You can set the option in the following dialog boxes: Capture Settings, New 
Sequence, New Project, and Sequence Preferences (Audio property page).

AFE Effects Support Table

The following table lists the level of support for conforming effects through 
AFE files created in the following Avid editing products:

• Symphony 4.0 and later

• Media Composer and Film Composer 11.0 and later

• Media Composer Adrenaline 1.0 and later

• Avid Xpress 5.0 and later

• Avid Xpress DV 3.0 and later

• Avid Xpress Pro 4.0 and later

Effects from previous versions might not have the same level of support. 

For information about special cases, see “Before You Begin” on page 20.

For information about effects that did not conform or did not conform 
completely, consult the AAF/AFE Conform Log that is displayed at the end of 
the conform process.
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n AAF files created in the following products do not support many of these 
effects:

• Media Composer Adrenaline v1.5 or later

• Avid Xpress Pro v4.5 or later

• Avid Xpress DV v4.5 or later

• NewsCutter Adrenaline FX v5.5 or later

• NewsCutter XP v5.5 or later

Use AFE files instead.

Legend

Support level Description

A Effect supported. The effect is imported as a corresponding 
Avid DS Nitris effect. All parameters and keyframes are set to 
match, as much as possible, the original effect.

B Imported with some parameters and keyframes. See the 
Comment field for information about each effect’s parameters.

C Imported without parameters or keyframes. Avid DS Nitris 
loads a preset that matches the defaults of the imported effect.

D Replaced when imported. Avid DS Nitris loads a similar effect 
without any parameters set.

NS Not supported. The effect is ignored by Avid DS Nitris.
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Category Avid effect
Avid DS Nitris 
effect

Support 
level Comment

Audio Mono Audio 
Gain

A

Mono Audio 
Crossfade

C

Audio Effects NS

AVX AVX Host effect A Only AVX 1.0 effects are supported. The 
corresponding AVX plug-in must be 
installed on the Avid DS Nitris system.

Avid FX AVX Host effect NS AVX 1.5 plug-in (Avid Xpress Pro Studio)

Blend 3D Warp DVE B The following parameters are supported:

• Scaling (X, Y), Position (X,Y, Z), 
Axis (X, Y), Rotation (X, Y, Z).

• Crop, Foreground Opacity, Foreground 
Swap Sources (two-sided transitions)

• Border (softness and animated colors 
not exact match; only constant colors for 
advanced keyframes)

Shape effects are not conformed.

Dip to Color Dip to Color A

Dissolve Dissolve A Reverse animation is not supported for 
Avid Xpress DV.

Fade from Color Fade A

Fade to Color Fade A

Picture-in-
Picture

DVE B Border softness and animated colors are not 
an exact match. Only constant colors are 
supported for advanced keyframes. PIPs that 
include nested titles do not conform. Blend 
Color is not supported for Avid Xpress DV. 

Superimpose Alpha Fade A
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Symphony Warp DVE B The following parameters are supported:

• Scaling (X, Y), Position (X,Y, Z), 
Axis (X, Y), Rotation (X, Y, Z).

• Crop, Foreground Opacity, Foreground 
Swap Sources (two-sided transitions)

• Border (softness and animated colors are 
not an exact match; only constant colors 
for advanced keyframes).

Shape effects are not conformed.

Box Wipe All Wipe A Animated colors are not an exact match.

Conceal All DVE C

Edge Wipe 4 Edge Wipes Wipe A Animated colors are not an exact match.

4 Diagonal 
Wipes

Wipe A Animated colors are not an exact match.

Lower Left and Lower Right do not export 
correctly for Symphony 3.x, Media 
Composer and Film Composer 10.x, and 
Avid Xpress 3.x.

Film 1.66 Mask Crop A

1.85 Mask Crop A

16:9 Mask Crop A

Anamorphic 
Mask

Crop A

Blowup DVE A

Film Dissolve Dissolve C

Film Fade Dissolve C

Film Mask Crop A

Illusion FX All AVX Host effect NS AVX 1.5 plug-ins

Image Avid Pan & 
Zoom

AVX Host effect NS AVX 1.5 plug-in

Category Avid effect
Avid DS Nitris 
effect

Support 
level Comment
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Blur Wipe D

Color Correction Color Correction B Secondary color correction is not 
conformed. For sequences created on Avid 
Symphony systems, only Color Correction 
that is applied as an effect from the Effect 
palette is conformed. See “Conforming 
Effects” on page 25. 

Color Effect Color Correction, 
Solarize, Posterize

B Solarize and Posterize do not produce the 
same results in Avid DS Nitris. Animation 
of parameters is not conformed. Gamma is 
not conformed.

Flip DVE A

Flip-Flop DVE A

Flop DVE A

Mask Crop A

Mosaic Graphics D

Paint Effect Graphics D

Region Stabilize AVX Host effect NS AVX 1.5 plug-in

Resize DVE A

Scratch Removal Graphics D

Spot Color Graphics D

Stabilize Stabilize D

Submaster A Avid DS Nitris creates a graphics container 
if tracks are nested in the effect.

Key Animatte Matte D

Chroma Key Blue-Green Keyer B Position, scale, crop, invert key, and key 
color are conformed. When promoted to 3D 
Warp, does not conform.

Category Avid effect
Avid DS Nitris 
effect

Support 
level Comment
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Luma Key Luma Keyer B Position, scale, crop, and invert key are 
conformed. Keys that use the Media 
Composer default (which keys out black) 
are conformed with the Avid DS Nitris 
default. Other luma adjustments are not 
conformed. When promoted to 3D Warp, 
does not conform.

Matte Key Matte container A For accurate conform, Matte and 
Foreground clips must be nested inside the 
Matte key on the Avid editing system. See 
“Conforming Matte Keys and Alpha 
Channels” on page 27.

RGB Keyer AVX Host effect D

SpectraMatte Chroma Keyer D AVX 2.0 plug-in

Ultimatte Chroma Keyer D

L-Conceal All DVE C

Matrix Wipe All Wipe D Replaced by left to right edge wipe.

Motion Effect 
(record side)

See Timewarp.

Motion Effect 
(source side)

Strobe Timewarp B For two-field media, the conformed result 
might display jitters.

Freeze Frame Timewarp A

Variable Speed Timewarp A

Peel All Effects Tree C

Plasma Wipes All Wipe D

Push All Effects Tree C

Reformat 14:9 Letterbox DVE A

16:9 Letterbox DVE A

4:3 Sidebar DVE A

Pan and Scan DVE A

Category Avid effect
Avid DS Nitris 
effect

Support 
level Comment
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Sawtooth 
Wipe

All Wipe B Number of teeth not supported.

Shape Wipe 4 Corners Wipe B Scaling and position not supported. 
Animated colors are not an exact match.

Center Box Wipe B Scaling and position not supported.

Circle Wipe B Scaling and position not supported. 
Animated colors are not an exact match.

Clock Wipe B Scaling and position not supported.

Diamond Wipe B Scaling and position not supported.

Ellipse Wipe B Scaling and position not supported.

Horizontal Bands Wipe B Scaling and position not supported.

Horizontal 
Blinds

Wipe B Scaling and position not supported.

Vertical Blinds Wipe B Scaling and position not supported.

Spin X Spin Effects Tree C

Y Spin Effects Tree C

Z Spin DVE C

Squeeze All DVE C

Timewarp Timewarp and 
Timewarp 
templates

Timewarp B Timewarp effects, except those rendered 
with FluidMotion™, are conformed as 
interpolated fields. Timewarp effects 
rendered with FluidMotion are conformed, 
but manual adjustments made in the Motion 
Effect Editor are ignored. For more 
information, see “Conforming Effects” on 
page 25.

Xpress 3D Ball 3D DVE D

Bumps 3D DVE D

Center burst Wipe D

Category Avid effect
Avid DS Nitris 
effect

Support 
level Comment
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AFE Titles Support Table

The following table lists the level of support for conforming titles created in 
the following Avid editing products:

• Symphony 4.0 and later

• Media Composer and Film Composer 11.0 and later

• Media Composer Adrenaline 1.0 and later

• Avid Xpress 5.0 and later

• Avid Xpress DV 3.0 and later

• Avid Xpress Pro 4.0 and later

Titles from previous versions might not have the same level of support. For 
detailed information, consult the AAF/AFE Conform Log that is displayed at 
the end of the conform process.

n When conforming a title, Avid DS Nitris always uses the Scale to Fit setting, 
rather than the Conversion Mode setting in Sequence Preferences.

For an explanation of the support level, see “Legend” on page 56.

Multiwave Wipe D

3D PIP DVE B Border softness and animated colors are not 
an exact match.PIPs that include nested 
titles do not conform. Background, 
Foreground Keying, Shadow, Shape, Spline, 
Target and Trail parameters are not 
conformed.

Page curl Wipe D

Page fold Wipe D

Quad Split Wipe D

Sine wave Wipe D

Slats Wipe D

Category Avid effect
Avid DS Nitris 
effect

Support 
level Comment
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Category
Support 
level Comment

General

Video formats A 4:3, 16:9 (NTSC and PAL) supported.

Format conversion A All formats supported.

Crawling and rolling 
titles

B Might appear different because of different interline and 
intercharacter metrics. See the Text section of this table.

Marquee titles B The following attributes are not supported:

• Edge effects (Profiles)

• Enable Image Blur option

• Use Main Surface Alpha shadow property

3D titles D Avid DS Nitris substitutes a 3D DVE effect. Title text and 
objects are not supported.

Background A Color and video both supported

Safe color NS Not supported

Object locking A Supported

Object grouping NS Objects are imported as ungrouped.

Blend color 8 directions 
(gradient)

B Appears slightly different, especially with 4 diagonal 
directions.

Low-pass filter B Avid DS Nitris applies antialiasing on individual 
graphics.

Effect parameters B All supported except crop parameter (no equivalent in 
Avid DS Nitris).

Text

Position B Supported, but might appear different because 
Avid DS Nitris and other Avid editing systems use 
different metrics for interline spacing.

Font B Supported, with substitution if necessary. Arial is the 
default font for substitution.
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Font size B Supported, but might appear different because 
Avid DS Nitris and other Avid editing systems use 
different font metrics.

Font style A Supported

Justification A Supported

Pair kerning A Supported

Global and per 
character kerning

NS Not supported because Avid DS Nitris and other Avid 
editing systems use different metrics for intercharacter 
spacing.

Leading B Supported, but might appear different because 
Avid DS Nitris and other Avid editing systems use 
different metrics for interline spacing.

Fill B Supported, except for blend transparency (no equivalent 
in Avid DS Nitris). 

Video fill is not supported. 

Outline B Supported, except for blend transparency (no equivalent 
in Avid DS Nitris). Maximum outline width is 10.

Shadow B Supported, except for shadow type depth (no equivalent 
in Avid DS Nitris). Maximum offset of 200.

Objects (line, rectangle, 
oval)

Position and size A Supported

Fill B Supported, except for blend transparency (no equivalent 
in Avid DS Nitris).

Outline B Supported, except for blend transparency (no equivalent 
in Avid DS Nitris).

Shadow NS No equivalent in Avid DS Nitris.

Category
Support 
level Comment
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Font Substitution for Titles

If there is no exact match for the font used in a title, Avid DS Nitris substitutes 
a similar font. If none of the specified fonts are available, Avid DS Nitris 
substitutes the Arial font.

n In some cases, you might need to convert the Macintosh font to a Windows font 
by using a font conversion program.

Working with Titles in Downconverted Projects

For HD projects offlined on a Media Composer or other Avid editing system, 
the preferred downconversion format is 16:9 anamorphic. Titles created in this 
16:9 aspect ratio (created in the 16:9 viewer) conform correctly. However, if 
the sources were downconverted to 16:9 letterbox and titles were created in the 
4:3 viewer, they do not conform correctly. There are two options to correct this 
problem:

• In the Avid editing system, create the titles in a 16:9 viewer. If the titles 
are centered near the bottom of the screen (such as subtitles), they will 
conform correctly. For more precise titles, use the next option.

Avid editing 
system font Avid DS Nitris font 

Chicago System or Mac Chicago

Courier Courier New

Geneva MS Sans Serif or System

Helvetica Arial

Monaco Terminal

New York MS Serif

Palatino Times New Roman

Times Times New Roman
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• In Avid DS Nitris, after importing the AFE file, adjust the titles 
individually.

- In the graphics layout, select the title.

- In the Object Properties list, click the Transformations button.

- On the Transformations property page, change the Scale X value to 
2.0. 

Creating Real-Time Graphics from Conformed Titles

After you have conformed the sequence, you might need to adjust conformed 
titles, so that they play as real-time graphics. The basic guidelines for real-time 
play are:

• All graphics objects must be applied on RGB channels (not on RGBA 
channels).

• Apply the Graphics effect directly on the clips and remove the filler.

In addition, make sure the graphics objects meet the following real-time 
conditions:

• Only the Airbrush, Color Blend, and Cutout effects can be played in real 
time. Color Gradient cannot be played in real time.

• Properties of the graphics objects must not be animated, except for the 
translation. Only translations in the X or Y axes can be played in real time. 

• Animation that moves at different speeds cannot be played in real time. 
Make sure all graphics objects move in the same direction (either X axis 
only or Y axis only) at the same speed.

For more information, see “Processing Graphics” in the Help.

To create real-time graphics from conformed titles:

1. With the conformed titles on the timeline, double-click the corresponding 
Graphics effect.

The Graphics layout is displayed.

2. Select all graphics objects.

3. On the Masks property editor, deselect the Alpha option in the Paint on 
Channel box.

4. Switch back to the Editing layout.
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5. Select the Graphics effect and cut it by pressing Ctrl+X.

6. Select the clip below the Filler (if any) and paste the effect on it by 
pressing Ctrl+V.

7. Delete the Filler.

Conforming AAF Files

AFE files are the preferred method for conforming projects that have created 
on other Avid editing systems. You must use AFE files if you are conforming 
from the following products:

• Media Composer Adrenaline v1.5 or later

• Avid Xpress Pro v4.5 or later

• Avid Xpress DV v4.5 or later

• NewsCutter Adrenaline FX v5.5 or later

• NewsCutter XP v5.5 or later

Avid’s goal is to work toward compliance with the AAF Edit Protocol and to 
make AAF files simpler and easier to read by other vendors. For this reason, 
AAF files from the product versions listed above are streamlined.

To conform projects using AAF files from earlier versions, follow the same 
workflow as AFE files (see “Workflow: Conforming AFE Files” on page 19).
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Exporting AAF Files from Avid DS Nitris

Avid DS Nitris lets you create an AAF file from a master clip. The AAF file 
contains composition information in a format that can be shared with other 
applications, such as Avid Media Composer. These files contain the metadata 
for the master clip but not the media itself, so they need to be used through 
shared storage.

For example, you might have finished an effects-intensive scene on 
Avid DS Nitris, created from MXF media (see “Sharing MXF Media” on 
page 49). If you need to send the sequence to Media Composer, first use the 
Timeline to Clip command to create a new master clip in a shared storage area. 
Then export the master clip as an AAF file, and import the AAF into Media 
Composer. On the Media Composer system, relink the master clip to the 
media generated by Avid DS Nitris.

Because Avid DS Nitris creates AAF files from master clips only, you need to 
use the Timeline to Clip command to create an AAF file for a sequence.

You can import an AAF file from Avid DS Nitris into the following products:

• Media Composer Adrenaline v1.5 or later

• Avid Xpress Pro v4.5 or later

• Avid Xpress DV v4.5 or later

• NewsCutter Adrenaline FX v5.5 or later

• NewsCutter XP v5.5 or later

To create an AAF file:

1. Right-click one or more master clips in a bin and select Export to AAF.

A browse dialog box is displayed. You cannot change any options; the 
entire master clip is exported.

2. Navigate to the folder where you want to save the file or files and click 
Select. 

AAF files are created with the same names as the clips.

3. On the Avid editing system, import the AAF file and link to the media.

See “Sharing Media Captured on Avid DS Nitris” on page 53 for 
information about linking to the media.



Conforming AAF Sequences with MediaManager

69

Conforming AAF Sequences with MediaManager

Avid Unity MediaManager is a media database that allows you to search for 
and manage media objects (master clips, sequences, effects, and any other type 
of object that references digital media) in an Avid Unity MediaNetwork shared 
storage environment.

If your Avid DS Nitris system is part of an Avid Unity environment that 
includes MediaManager, you can use MediaManager to share clips and 
sequences through AAF files.

n For the highest level of conform, Avid recommends using AFE files, not AAF 
files, for conforming projects from other Avid applications. For more 
information, see “Conforming AAF Files” on page 67.

You can work with MediaManager in two different ways:

• As an embedded view in the Avid DS Nitris application

• As a separate web browser

n Currently Avid DS Nitris lets you use MediaManager to check out AAF 
sequences only. You cannot check files in to MediaManager.

n For complete information on how to use MediaManager, see the 
MediaManager documentation. Not all features of MediaManager are 
currently supported in Avid DS Nitris.

To use MediaManager with Avid DS Nitris you need the following:

• Your Avid DS Nitrisworkstation must be a client in an Avid Unity 
workgroup environment.

• You must have access to a server running MediaManager v3.7 or later. 
(This server is represented by the MediaManager host name).

• You must have a MediaManager account.

• To view the media, you must index the storage device for the media—see 
“Managing Your Storage Areas” in the Avid DS Nitris Installation and 
Administration Guide or the Help.

You do not need to load MediaManager software on your Avid DS Nitris 
system.
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Setting Up MediaManager

To use MediaManager as an embedded view, you must specify the name of a 
MediaManager server (the host name). You can specify more than one server. 
If you will always use the same MediaManager account, you can set up 
automatic login to the MediaManager host.

To specify a MediaManager server:

1. In an Avid Explorer panel, open the Views folder and click 
MediaManager.

An Avid Explorer window opens.

2. Double-click the Add MediaManager icon.

The MediaManager Host Configuration dialog box opens.
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3. Type the MediaManager Host Name and click OK.

An icon for the MediaManager host is displayed in the view.

To set up automatic login to the MediaManager host:

1. Right-click the MediaManager host icon and select Modify Host 
Settings.

The Add Login Information dialog box opens.

2. Type your user name and password.

3. Click OK.

To remove a MediaManager host:

t Right-click the MediaManager host icon and select Remove.

Checking a Sequence into MediaManager

To transfer a sequence through MediaManager, use the MediaManager check-
in feature. Do not export the sequence as an AAF file.

To check a sequence into MediaManager:

1. On an Avid editing system, right-click the sequence that you want to 
check in and select Check in AAF to Media Manager.

A message box prompts you to enable associations for the referenced 
clips.

2. Click OK.
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Conforming a Sequence with MediaManager

The steps for conforming an AAF sequence with MediaManager are similar to 
those for conforming an AAF file. 

To conform a project through MediaManager:

1. Open MediaManager by doing one of the following:

t Open a web browser and connect to the MediaManager server.

t In the MediaManager Setup view, double-click the MediaManager 
host icon.

If you did not enable automatic login, the MediaManager login screen 
is displayed.

2. Type your account name and password.

The MediaManager browser is displayed. 
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3. Locate the sequence you want to conform. You can sort the sequences to 
help you locate AAF sequences.

4. Follow the steps in “Step 3: Create a Sequence and Master Clips” on 
page 40.

If you are working with MediaManager in a web browser, the AAF/AFE 
settings are displayed after you drag a sequence to the timeline or a bin.

For information about AAF/AFE settings, see “AAF/AFE View” in the 
Help.
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Chapter 2
Conforming OMF, EDL, and ALE 
Files

This chapter describes how to load an Open Media Framework (OMF), Edit 
Decision List (EDL), or Avid Log Exchange (ALE) file into Avid DS Nitris 
and recreate a sequence on which you can apply further edits and effects.

This chapter includes the following topics:

• Workflow: Conforming OMF, EDL, and ALE Files

• Conforming OMF Compositions

• Conforming EDLs

• Conforming ALE Files
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Workflow: Conforming OMF, EDL, and ALE Files

The following illustration shows the basic steps in the conform process using 
OMF files, EDLs, or ALE.

3

2

1 Import the EDL, OMF, or 
ALE file.

Conform the file to 
Avid DS Nitris.

Log as clips in the Avid Explorer. Load directly onto timeline.

Capture media.

Recapture media 
from tape or file into 
Avid DS Nitris.

or or
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Conforming OMF Compositions

OMF (Open Media Framework) files facilitate the transfer of digital media 
from one system to another. They can contain both media and composition 
information. An OMF composition is basically an advanced form of an EDL. 
It contains instructions for transitions, timewarps, keys, titling, and some other 
effects information. Avid DS Nitris preserves all the layering information 
from an OMF file, so that you can select events and layers that you want to 
recreate on the timeline.

n Support for OMF media is limited to the import and export of audio 
media only.

n Avid DS Nitris can import only OMF 2.0 files.

Avid DS Nitris supports many types of Media Composer and Symphony 
effects. For a complete list, see “OMF Level of Support” on page 86. 
However, the preferred method of conforming sequences is through AFE files. 
For more information, see “Using AFE Files” on page 18.

Opening an OMF File

You can import OMF files created on other systems. By using the OMF file 
format to transfer sequences from an offline system to Avid DS Nitris, you can 
quickly import sequences with most of the offline editing and effects work 
intact.

To open an OMF file:

1. Do one of the following:

t In the view switcher, click the OMF button.

t Select View > Single-Instance Views > OMF.

2. From the OMF view, click the Load OMF button and select a file from 
the Open dialog box.

The selected OMF file is displayed in the OMF view.
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When you load an OMF file with more than one composition, you are 
prompted to select the composition to import. 

For more information about the OMF view, click the Help button.

Conforming an OMF File

You can log your clips in the Avid Explorer to create master clips that can be 
reused in other sequences, recreate your sequence in Avid DS Nitris by 
loading the OMF file onto the timeline, or both. It’s a good idea to do both, so 
that when a clip is deleted from the timeline, you always have the master clip 
in a folder. You also have the option of importing any audio media in the OMF 
file.

Conforming an OMF File without Audio Media

To conform an OMF file without audio media:

1. Open a new sequence in your project.

2. Load an OMF file into the OMF view.

OMF tree

OMF tools Record in-point
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3. In the OMF view, click the Conform OMF button.

The OMF Conform dialog box opens.

4. If you want to log clips, select the folder in which you want to create the 
clips. The default folder is displayed in the text box at the top of the dialog 
box. Click the browse (...) button to select a new folder.

5. Select one of the following options:

Option To

Create Logs Log the clips in the selected folder.

Create Timeline 
Clips 

Recreate the sequence on the timeline based on 
the composition information in the OMF file.

Create Both Log the clips in the selected folder and recreates 
the sequence based on the composition 
information in the OMF file.
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6. To add material before the in-point and after the out-point of all tape 
sources, type the appropriate number of frames in the Heads and Tails 
text boxes. 

7. To add the project name from the OMF file to the tape sources for the 
master clips, select the Force creation of external tape sources option.

8. If you need to reconfigure the incoming audio tracks, select a tape name 
from the Tape Name list and assign the audio tracks to the audio channels 
of your clip by clicking in the audio channel routing matrix.

n You can assign the audio tracks differently for each tape name.

9. Click the Set button after you have assigned the audio tracks for each tape 
name to save the settings.

10. Click the Conform button to begin conforming the OMF.

The clips, transitions, and supported effects are recreated on the timeline 
using the composition information and empty master clips are created in 
the selected folder. When you open the folder in a bin, the clip icons are 
red since no media has been imported yet.

Effects that are not supported by Avid DS Nitris are marked by effect bars 
that have been deactivated. These effect bars indicate where the effect was 
originally placed.
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If there are any unsupported effects, a message is displayed, asking if you 
would like to view the error log. If you click Yes, the list is generated and 
displayed in the Conform Error Log dialog box.

The Conform Error Log dialog box displays the in and out-points of the 
effect, the name of the original effect, as well as a brief description of the 
type of error that occurred.

11. To save this log as an .html file, click the Save button.

The Save As dialog box opens.

12. Navigate to an appropriate folder, type a name for the log and click Save.

The log is saved as an .html file and can be viewed in any HTML browser.

Conforming an OMF File with Audio Media

To conform an OMF file with audio media:

1. Open a new sequence in your project.

n OMF files that are exported at a frame rate must be conformed in the timeline. 
OMF files that are exported as sample-accurate must be conformed in an 
audio container. 

2. Load an OMF file which contains audio media into the OMF view.
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3. In the OMF view, click the Conform OMF button.

The OMF Conform dialog box opens.

4. If you want to log clips, select the folder in which you want to create the 
clips. The default folder is displayed in the text box at the top of the dialog 
box. Click the browse (...) button to select a new folder.

5. Select one of the following options:

Option To

Create Logs Log the clips in the selected folder.

Create Timeline 
Clips 

Recreate the sequence on the timeline based on 
the composition information in the OMF file.

Create Both Log the clips in the selected folder and recreates 
the sequence based on the composition 
information in the OMF file.



Conforming OMF Compositions

83

6. To add material before the in-point and after the out-point of all tape 
sources, type the appropriate number of frames in the Heads and Tails 
text boxes. 

7. If you need to reconfigure the audio tracks, select a tape name from the 
Tape Name list and assign the audio tracks to the audio channels of your 
clip by clicking in the audio channel routing matrix.

n You can assign the audio tracks differently for each source name.

n The audio media will be imported using the assignment specified in the audio 
channel routing matrix and not those originally set in the file.

8. Click Set after you have assigned the audio tracks for each source name to 
save the settings.

9. Select the Import Audio Data option.

10. Select one of the following options:

- Import All Media to import all the audio media contained in the 
OMF file into the current project.

- Only Import Used Media to import only the audio media used in the 
actual sequence into the current project.

11. From the Sample Rate list, select a sampling rate at which to convert your 
audio media. The higher the sampling rate, the more accurate the 
conversion will be.

n Make sure the sample rate you select matches the sample rate of your current 
sequence. If the sample rates do not match, no audio media will be available 
for playback. 

n To play back the audio media, you would have to change the sample rate of the 
sequence in the Sequence Preferences dialog box.

12. From the Bit Depth list, select a bit depth value. The higher the value, the 
more precise the audio conversion will be.

13. From the Capture To list, select a storage area on which your audio media 
will be stored.
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14. Click the Conform button to begin conforming the OMF.

Depending on the settings you chose, any of the following will occur:

- The clips, transitions, and supported effects are recreated on the 
timeline using the composition information.

- Master clips are created in the selected folder.

- The audio media is imported to your disk array. 

Since no video media was imported, the video clip icons that appear when 
you open the folder in a bin are red, indicating that no media has been 
captured yet.

Effects that are not supported by Avid DS Nitris are marked by effect bars 
that have been deactivated. These effect bars act as markers to indicate 
where the effect was originally placed.

n Although Avid DS Nitris may not be able to import certain effects, it will keep 
any keyframed information, which you can use as a reference to recreate the 
effect.

If there are any unsupported effects, a user message is displayed that asks 
you if you would like to view the generated list. If you click Yes, the list is 
generated and displayed in the Conform Error Log dialog box.

The Conform Error Log dialog box displays the in and out-points of the 
effect, the name of the original effect, as well as a brief description of the 
type of error that occurred.

15. To save this log as an .html file, click the Save button.

The Save As dialog box opens.

16. Navigate to an appropriate folder, type a name for the log and click the 
Save button.

The log is saved as an .html file and can be viewed in any browser.

Exporting an OMF File

If you need to do some audio finishing on Pro Tools, you can create, save, and 
export OMF files for the audio portion of your sequence. When you create and 
save an OMF file from within Avid DS Nitris, both the audio media and its 
composition information can be included.You can then transfer the file to 
another system.
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Note the following:

• Only the audio portion of your sequence can be exported to an OMF file. 
Any video clips on the timeline are ignored when you create an OMF file.

• No audio effects are exported, but edit points are created to show where 
effects were originally placed.

• You need DigiTranslator™, a Pro Tools option, to convert the OMF files 
into a format that Pro Tools can read. If DigiTranslator is not supplied 
with your Pro Tools application, you need to purchase and install it. See 
the Digidesign web site www.digidesign.com.

• Avid DS Nitris exports only OMF 2.0 files.

• OMF files have a size limit of 2 GB. If you are unable to export an OMF 
file for a large sequence, you need to divide the sequence into smaller 
segments.

To create and save an OMF file with audio media:

1. From the OMF view, click the Timeline to OMF button to create an OMF 
file of the audio portion of the current sequence.

The Export Composition dialog box opens.

2. Select the Embed Media option to include the media in the OMF file you 
are creating.

3. Select the Consolidate option to include only the media that is being used 
on the timeline.

http://digidesign.com
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n If the Consolidate option is not selected, the entire audio clip will be included 
in the OMF file.

4. From the Bit Depth list, select 16 (16-bit audio) or 24 (24-bit audio). The 
higher the bit depth value, the more precise the audio conversion will be.

5. In the Handles Length box, do the following:

- Add a number in the Heads text box if you want to add extra frames 
before the material used on the timeline. These additional frames will 
be included in the OMF file for source material coming from tape 
only.

- Add a number in the Tails text box if you want to add extra frames of 
material after the end of the material used on the timeline. These 
additional frames will be included in the OMF file for source material 
coming from tape only.

6. Click OK.

The Save As dialog box opens.

7. Navigate to an appropriate folder, type a name in the File Name text box, 
and then click the Save button.

All the information obtained from the audio tracks on the timeline are 
saved as an OMF file in the location you specified. You can now transfer it 
to another system.

OMF Level of Support

Avid DS Nitris supports many effects that are imported via OMF from Media 
Composer 10.0 and later and Symphony 2.1 and later. However, the level of 
support can vary; consult the following table and legend for full details.

n The preferred method of conforming sequences is through AFE files. For more 
information, see “Using AFE Files” on page 18.

n The support information for the Audio (Export) category is for use with Pro 
Tools.
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Category Effect
Support 
level Comment

3D E

Audio 
(Import)

Transitions D All audio transitions are replaced with a 
crossfade.

Audio Effects NS

Audio 
(Export)

Mono Audio 
Gain

C

Mono Audio 
Transition

D Replaced with an audio transition. No 
parameters are exported.

Audio Effects NS

Blend 3D Warp E

Dip to Color E

Dissolve C

Fade from Color E

Fade to Color E

Picture-in-
Picture

A

Superimpose A

Legend

A = Effect supported. The effect is imported as a corresponding Avid DS Nitris effect. All 
parameters are set to match, as much as possible, the original effect.

B = Imported with some parameters.

C = Imported without parameters.

D = Replaced when imported.

E = Not supported. Effect replaced by a “null” fade and keyframe locations are kept.

NS = Not supported. The effect is ignored by Avid DS Nitris.

AVX = AVX plug-in. Effect must be installed on an Avid DS Nitris system for the effect to be 
loaded. Only AVX 1.0 plug-ins are supported.
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Box Wipe All A

Conceal All D Replaced by corresponding SMPTE 
wipes.

Edge Wipe All A

Film 1.66 Mask B Background color not imported.

1.85 Mask B Background color not imported.

16:9 B Background color not imported.

Anamorphic 
Mask

B Background color not imported.

Blowup E

Film Dissolve C

Film Fade C

Mask B Background color not imported.

Image Color Correction E

Color Effect C

Flip A

Flip-Flop A

Flop A

Mask B Background color not imported.

Paint Effect E

Pan and Scan A

Resize B Background color not imported.

Scratch Removal E

Spot Color E

Submaster A

Key Animatte E

Category Effect
Support 
level Comment
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Chroma Key C/D If used as a transition, then imported as 
a dissolve.

Luma Key E

Matte Key B

RGB Keyer AVX

L-Conceal All D Replaced by corresponding SMPTE 
wipes.

Marquee Marquee AVX 1.5 AVX 1.5 effects are not supported in 
Avid DS Nitris.

Matrix Wipe Grid E

One-way Row E

Speckle E

Spiral E

Zig Zag E

Peel All D Replaced by corresponding SMPTE 
wipes.

Push All D Replaced by corresponding SMPTE 
wipes.

Shape Wipe 4 Corners E

Center Box D Replaced by circle wipe.

Circle A

Clock A

Diamond D Replaced by circle wipe.

Ellipse D Replaced by circle wipe.

Horizontal Bands E

Horizontal 
Blinds

E

Category Effect
Support 
level Comment
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n Acceleration curves are always exported by Symphony and Media Composer 
as linear curves.

Only the following effects applied to a Filler track in Media Composer and 
Symphony are imported:

• Blend Masks

• Pan and Scan

An effect applied to a Filler track is converted into a timeline effect in 
Avid DS Nitris. This may produce unwanted results, since an effect applied to 
a Filler track in Symphony or Media Composer systems only impacts the 
tracks below it. In contrast, when the effect is conformed to Avid DS Nitris as a 
timeline effect, it is applied to all tracks.

Vertical Blinds E

Spin X Spin B Border not supported. Effect is similar 
in Avid DS Nitris, but not identical.

Y Spin B Border not supported. Effect is similar 
in Avid DS Nitris, but not identical.

Z Spin B Border not supported.

Squeeze All D Replaced by corresponding SMPTE 
wipes.

Ultimatte Keyer AVX

Timewarp Strobe A

Freeze Frame A

Variable Speed A Symphony and Media Composer don’t 
export negative speed values.

Category Effect
Support 
level Comment
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Conforming EDLs

Avid DS Nitris supports the import of edit decision lists (EDLs). An EDL is a 
detailed list of the edits contained in a sequence, including all the timecode 
and supported effects information required to recreate the sequence in an 
online session. Avid DS Nitris accommodates EDLs from many different 
systems. It is compatible with the standard EDLs, as well as CMX, GVG, and 
OMF formats.

The EDL file is organized into a series of chronological instructions called 
events. You can use these events to create clips or to completely recreate the 
sequence on the timeline.

Avid EDL Manager

Avid EDL Manager is an application that lets you convert between different 
EDL formats, such as Sony, GVG, or CMX. You can also convert EDL files to 
OMF 1.0 files. Since Avid DS Nitris only supports OMF 2.0 files, you will 
need to further convert the OMF 1.0 files, so that they can be read by 
Avid DS Nitris.

You can use the Avid EDL Manager to read EDL files from RT-11 disks and 
then save the files in CMX or GVG format for import into Avid DS Nitris. 
Avid DS Nitris cannot read RT-11 disks.

You can also use the Avid EDL Manager to create an EDL that displays 
additional types of information, such as comments or patches. You can specify 
the different audio and video tracks in the sequence, as well as specify the 
assembly modes that the online edit controller uses when creating your 
sequence. For more information, refer to the Avid EDL Manager User’s 
Guide.

The Avid EDL Manager application and guide are available on the 
Avid DS Nitris Drivers CD. 
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EDL Processor

The EDL Processor is an application that lets you modify and save EDL files. 
You can use the application to modify the EDL content in many different way, 
from changing its title to converting timecodes. One use of the application is 
conversion of a sequence’s timecode from 30 fps to 24 fps.

The EDL Processor and Help file are available for download from the Utilties 
page of the Avid DS Support Center at http://www.softimage.com/avidds.

Opening an EDL File 

The EDL view lets you import an EDL file produced on any external system, 
and capture material based on the edits in that EDL. 

When you import an EDL into Avid DS Nitris, it appears in the EDL view, 
where you can see the list of events. After importing your EDL into 
Avid DS Nitris, you can select the events that you want to recreate. To do this, 
you can either log the events as master clips in the Avid Explorer, or edit the 
list onto the timeline, or both. You can then capture media from either the clips 
in the Avid Explorer or on the timeline.

n You can only recapture logged clips created from an EDL that originated on 
tape. Avid DS Nitris does not support recapture from file for logged clips 
created from an EDL.

Clip names are created from the event number. If you have more than one EDL 
in a project, however, there will be at least two clips with the same name. To 
avoid the conflict, the name of the EDL is appended to the clip name. 
For example:

001 (NewYork1)
001 (NewYork2)

After the clips are created, you can rename them at any time. For more 
information, see “Renaming Project Files” in the Avid DS Nitris Editing Guide 
or the Help.

http://softimage.com/avidds
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To open an EDL:

1. Do one of the following:

t In the view switcher, click the EDL button.

t Select View > Single-Instance Views > EDL.

The EDL view is displayed.

2. To load a new EDL, click the Load EDL button.

The Open dialog box opens.

3. Select an EDL. If you know the system from which the EDL was 
generated, select the appropriate file type (DS, CMX, GVG).

4. In the Comment Placement box, indicate whether you want comments 
placed above or below the corresponding edit. 

5. Click the Open button.

The selected EDL is displayed in the EDL view.

If you selected the wrong file type, you are prompted to convert the file to 
the appropriate type.
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For more information about the EDL view, click the Help button.

Setting EDL Properties

You can specify options for the currently displayed EDL in the EDL 
Properties dialog box, such as displaying timecodes as drop frame and 
determining comment placement. 

To set EDL properties:

1. Right-click the main area of the EDL view and select Properties.

The EDL Properties dialog box opens.

2. Use the controls in the EDL Properties dialog box to set the EDL 
properties. 

EDL name EDL tools Record in-point

Edit list
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For information about the EDL Properties dialog box, click the Help button.

Conforming an EDL File

When conforming your EDL, you have the choice of logging the events in the 
Avid Explorer, recreating the list of events on the timeline, or both. Once the 
events are logged, you can capture the media at any time from either the Avid 
Explorer or the timeline. For more information, see ”Batch Capturing” in the 
Help.

Before conforming your EDL, you should check if there are any layers to be 
composited. Offline editors often create multiple EDLs because the 
convention is to put separate layers into separate EDLs. Any audio or video 
events in the list are automatically loaded onto the appropriate tracks.

During the conform process, you can set up the appropriate heads and tails 
values for each clip. This is important if you need additional material at the 
beginning and end of each clip to do minor changes during the final stage of 
the edit. You can also configure the audio channel patching for each tape.

If you recreate your sequence on the timeline, you may want to process a 
rough cut and proof it against the original EDL. You can do this by reloading 
the EDL onto a new video track, adding a fade or crop effect to the video track 
and processing it, and then playing the sequence to make sure that the cuts and 
transitions on the two tracks occur in sync.

If the proofing session is successful, you can then remove the video track you 
added and continue to add effects and finishing touches to the original 
sequence.

To conform an EDL file:

1. Open a new sequence in your project.

2. Import or open an edit list in the EDL view.

3. From the EDL view, click the Conform EDL button.

The EDL Conform dialog box opens.
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n You can capture all events in the edit list, or hold down the Ctrl key and click 
the EDL events associated with the source material you want to capture.

4. If you want to log clips, select the folder in which you want to create the 
clips. The default folder is displayed in the text box at the top of the dialog 
box. Click the browse (...) button to select a new folder.

5. Select one of the following options:

6. Select the Overwrite Video Track option to overwrite clips on the 
timeline at the same timecodes. If this option is not selected, the clips will 
be added to a new video track.

Option To

Create Logs Create a log of events in the selected folder.

Create Timeline 
Clips

Recreate the events on the timeline.

Create Both Create both a log of events in the selected folder 
and a sequence based on the events in the EDL.
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7. To add material before the in-point and after the out-point of all tape 
sources, type the appropriate number of frames in the Heads and Tails text 
boxes. 

8. If you need to reconfigure the audio tracks, select a tape name from the 
Tape Name list and assign the incoming audio tracks to the audio channels 
of your clip by clicking in the audio channel routing matrix.

n You can assign the audio channels differently for each tape name or you can 
multi-select the tape names, and make the audio channel assignment the same 
for all of them.

9. Click the Set button after you’ve assigned the audio tracks for each tape 
name to save the settings.

10. Click the Conform button to begin conforming the EDL.

The events are recreated on the timeline as empty clips, and master clips 
are created in the selected folder for each event. When you open the folder 
in a bin, the clip icons are red since they have no media yet.

Audio channel routing matrix
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n Audio events in the edit list do not support stereo clips. When a stereo clip (two 
streams) is created on the timeline, it is split onto two mono tracks; each track 
holds one stream.

Creating Layers from an EDL

Receiving multiple EDLs for different levels in a composite occurs frequently. 
For example, there may be an EDL for the background and another for the 
foreground. When this happens, both layers must be in sync on the timeline. 
You can either place the layers on video tracks, which allows more than one 
layer to be active at a time, or you can place these two layers in a container 
clip.For more information, see “Creating a Composite Container Clip” in the 
Avid DS Nitris Editing Guide or the Help.

To create a layer from an EDL:

1. Open a new or existing sequence in your project.

2. Import or open an edit list in the EDL view.

3. From the EDL view, click the Conform EDL button.

The EDL Conform dialog box opens.

4. Select one of the following:

- Create Timeline Clips to recreate the events on a video track.

- Create Both to create both a log of events in the selected bin and a 
sequence based on the events in the EDL.



Conforming EDLs

99

5. Deselect the Overwrite Video Track option, so that each EDL is 
recreated on an individual video track.

6. Set the Heads and Tails and configure the audio inputs as required—see 
“Conforming an EDL File” on page 95. 

7. Click Conform to recreate the events on a video track on the timeline.

n Avid DS Nitris ignores the current setting of the Ripple mode when performing 
an EDL to timeline. By default, all EDL conforms are performed with the 
Ripple mode off.

Modifying an EDL File

Avid DS Nitris lets you modify certain properties of the EDL after you’ve 
loaded it into the EDL view. You can change the name of the source tape, as 
well as ripple the source timecodes.

Changing the Source Tape Name

If your source tape name is too long, or the name of the tape has changed 
between the offline and the online, you can modify the name of your tape 
directly in Avid DS Nitris. Once you’ve loaded an EDL into the EDL view, 
you can modify the source name of any one of the sources.

To change the source name of a tape in an EDL:

1. Load an EDL into the EDL view.

2. Right-click the main area of the EDL view and select Change Source 
Name.

The Change Source Name dialog box opens.

3. From the Old Source Name list, select the name of the tape you want 
to change.

4. Type the new name in the New Source Name text box and click OK.

The Source Name is changed in the EDL view.

Rippling the Source Timecodes

If there’s a time delay between your master tapes and the offline EDL list, or 
the time of an event has changed, you can push or ripple any one of the source 
timecodes forwards or backwards directly in Avid DS Nitris.
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To ripple all source timecodes in an EDL:

1. Load an EDL into the EDL view.

2. Right-click the main area of the EDL view and select Ripple Sources.

The Ripple Sources dialog box opens.

3. In the Ripple By timecode box, type the amount by which you want the 
source timecodes to move.

n To ripple the source timecode backwards, type the amount preceded by a 
minus (–) sign in the Ripple By timecode box.

4. Click OK.

The source timecodes of all your source tapes are modified by the amount 
you specified.

To ripple the source timecode of one event in an EDL:

1. Load an EDL into the EDL view.

2. Select the event in the Edit list.

3. Right-click and select Ripple Sources.

The Ripple Sources dialog box opens.

4. In the Ripple By timecode box, type the amount by which you want the 
source timecode to move.

n To ripple the source timecode backwards, type the amount preceded by a 
minus (–) sign in the Ripple By timecode box.

5. Click OK.

The source timecode of that one event is modified by the amount 
you specified.

To ripple the timecodes of all events from one source:

1. Load an EDL into the EDL view.

2. Right-click the main area of the EDL view and select Ripple Sources.

The Ripple Sources dialog box opens.

3. Select the Apply To All Edits From This Source option to modify the 
source timecode of one of your source tapes.

4. Select the name of the tape from the list.
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5. Type the amount by which you want the source timecodes to move in the 
Ripple By timecode box and click OK.

All the timecodes for that one source tape are modified by the amount 
you specified.

Exporting an EDL File

If you want to perform certain tasks on another system, you can create an EDL 
of your current sequence, save it to file, and then transfer it. 

Avid DS Nitris creates an EDL for each track of your current sequence and for 
some effects. Depending on the track, the EDL contains information about the 
timecode, transitions, and supported effects. Once you’ve created EDLs of 
the current sequence, you can save them and transfer the information to 
another system.

To create and save EDLs of the current sequence:

1. From the EDL view, click the Timeline to EDL button to create one or 
more EDLs of the current sequence.

2. If Avid DS Nitris created more than one EDL, select the EDL that you 
want to display from the EDL name list.

3. Click the Save EDL button to save your EDL to file.

The Save As dialog box opens.

4. Navigate to an appropriate folder, type a name in the File Name text box, 
and click the Save button.

The EDL is saved in the location you specified.

Printing an EDL File

When you need a hard copy of your EDL for review or want to keep a hard 
copy as a reference, you can print one out from within the EDL view. You can 
set the number of copies to print, as well as the orientation of the page.

To print an EDL file:

1. Load an EDL into the EDL view.

2. From the EDL view, click the Print button.

The Print EDL dialog box opens.
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3. In the Number of Copies text box, type the number of copies you want 
to print.

4. Select a page orientation for the EDL.

5. Click the Print button.

The EDL is printed on your default printer.

n To change your default printer, modify the printer settings in Windows.

Proofing

If you recreated your sequence on the timeline, you may want to process the 
rough cut, and proof it against the original EDL to make sure that the timing 
is correct.

To proof the EDL to timeline:

1. Reload the EDL onto a new video track. Make sure you deselect the 
Overwrite Video Track option.

2. Add a diagonal wipe or crop effect to the video track.

3. Process the effect.

4. Play the sequence to make sure that the cuts and transitions on the two 
tracks occur in sync.

If the proofing session is successful, you can remove the video track and 
continue to add effects and finishing touches to the original sequence.

Conforming ALE Files

Avid DS Nitris supports ALE (Avid Log Exchange) files—a file format 
specifically designed to hold information about log files generated by other 
Avid systems. ALE files contain only information about the source material, 
so you can’t import sequences, effects or other higher level information.

n Although the ALE file format was designed for log files generated by Avid 
editing systems, many other systems can output ALE files as well.

You can use ALE files to transfer information from MediaLog to 
Avid DS Nitris. MediaLog is a tool that helps you select and log footage 
before your editing session. Although you can log footage with 



Conforming ALE Files

103

Avid DS Nitris, using MediaLog can free up your Avid DS Nitris system for 
editing and effects. After logging shots, you can use Avid DS Nitris to digitize 
and edit the footage.

n MediaLog is shipped with your Avid DS Nitris system. For complete 
information about MediaLog, see the MediaLog Help or the Avid MediaLog 
User’s Guide (available in Adobe Acrobat format on the MediaLog CD). 
MediaLog is also available in the Download area of the Avid DS Nitris 
Customer Support web site.

You can import bins created in MediaLog into Avid DS Nitris. To do this, 
either:

• Export the bin as an ALE file. You can then load the ALE file into 
Avid DS Nitris and create logs. 

• Export the project and bins as an AFE file. 

For more information, refer to the Avid MediaLog User’s Guide or “Exporting 
AFE Files from MediaLog” on page 35.

n To import an ALE file into Avid DS Nitris, make sure the following columns 
are displayed in MediaLog:

• End

• Start

• Tape

• Tracks

You can display other columns as well. Only columns that are displayed in 
MediaLog will be displayed in Avid DS Nitris.

Importing an ALE File

ALE files can be imported and interpreted by Avid DS Nitris.

To import an ALE file

1. Select View > Single-Instance Views > ALE Import.

2. In the ALE Import view, click the Load ALE File button.

3. In the Open dialog box, select a file.
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The selected ALE file appears in the ALE Import view.

For information about the ALE view, click the Help button.

You can view the global properties of an ALE file, which includes the location 
of the file and the values of various global properties, such as video/audio 
format, fps, and more in the ALE Import view. 

To get information on an ALE file:

t Click the Info button.

Logging Clips from an ALE File

After you’ve imported an ALE file into Avid DS Nitris, you can select the 
clips you want to log. However, before you can log master clips, the clips must 
have associated values for the following properties:

• End

• Name

• Start

• Tape (or a global tape property)

• Tracks

If any of these properties are missing an associated value, the Create Logs 
button appears dimmed and you need to supply the missing value.

Load ALE ALE InfoCreate Logs
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To log master clips from an ALE file:

1. Load an ALE file into the ALE Import view—see “Importing an ALE 
File” on page 103.

2. Select the clip(s) you want to log in a bin by clicking them. To select more 
than one clip at a time, select a clip, hold down the Ctrl key and click the 
others.

n If no clips are selected in the ALE Import view, Avid DS Nitris creates logs for 
every clip.

3. In the ALE Import view, click the Create Logs button.

The Create Logs dialog box opens.

4. Select the folder in which you want to create the logged clips. The default 
folder is displayed in the text box at the top of the dialog box. Click the 
browse (...) button to select a new folder.

5. To add material before the in-point and after the out-point of all tape 
sources, type the appropriate number of frames in the Heads and Tails text 
boxes. 

6. If you need to reconfigure the audio tracks, select a tape name from the 
Tape Name list and assign the audio tracks to the audio channels of your 
clip by clicking in the audio channel routing matrix.

Routing 
matrix
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n You can assign the audio tracks differently for each source name.

7. Click the Set button after you have assigned the audio tracks for each tape 
name to save the settings.

8. Click the Create Logs button to begin creating logs from the ALE file.

In the Avid Explorer, master clips are created for each selected clip. Once 
the clips have been logged, you can capture the media at any time.

n Only source material from tape can be recaptured from clips logged from an 
ALE file.
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